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 1 Notes for the SURE 110 release 
This document describes the major changes accomplished in all 110.x releases of the SURE software. The 
previous release was 100.4.  
 
 
 

 1.1 Introduction 

Chapter 4 gives the complete overview of all changes that we made in release 110. Tasks that are only applicable 
for the SURE backend on Windows are marked as such. All other tasks are applicable for both backends, or for 
the SUREforWindows GUI. 
 
Details about the installation and use of SURE backend on Windows can be found in document  
 ‘SURE backend on Windows – reference guide’ 
 
 
 

 1.2 Migration 

Overview of previous releases: 
Release Release date Migration Data 

conversion 
Database 
reorganization 

90.x November 30, 2019 80.x → 90.x  Yes No 
100.x April 19, 2021 90.x → 100.x No No 
110.x October 8, 2023 100.x → 110.x Yes No 

 
Currently the software is compiled with MCP-601 compilers and MCP-631 compilers. You may encounter 
problems if you are running on an MCP level older than 601. 
 
Each new release provides new features in the software. It is our intention to implement these new features 
seamless with the existing features and procedures. However, in some cases it is necessary to perform database-
reorganization and/or data conversion.  

- The last database reorganization was at release 50.0 in December 2001.  
- The last previous repository-data-conversion was at release 100 in April 2021. 

 
Programs of two successive releases are NOT (fully) compatible if a reorganization or conversion is necessary to 
migrate from one release to the other.  
 
In some cases, it can be inconvenient for a site to install a new release, and then the site may decide to skip a 
release and to wait for a next release.  
It is obvious that the required data-conversions and database reorganizations cannot be skipped. These 
conversions and reorganizations will automatically be executed in the correct order when a new software release 
is installed. 
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The following table shows how to migrate from one release to another:  
From To How 

90.x 100.x See the notes of SURE release 100. 
 

100 x 110.x RUN RESPECT/REPOSITORY (“UPGRADE-REPOSITORY”) 
- Set the repository level to 110.2. 

 
RUN RESPECT/REPOSITORY (“LOAD-MESSAGES E”) 

- Load new and changed error messages. 
 

RUN RESPECT/REPOSITORY (“LOAD-FORMATS E”) 
- Load new and changed screens (used by OBJECT/RIS/MENU). 

 
The last run date of each program is copied to a relation. 
The Drop-Down-Box definitions are improved. 
 

 
The standard installation procedure via RESPECT/SETUP (with program RIS/INSTALL and job WFL/RIS/INSTALL) 
performs the correct data conversions. 
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 1.3 Installing the mainframe software 

Before you start with the installation, we advise you to: 
- Read the list with completed tasks. 
- Contact ITSforSURE, to make sure that we are available for support. 

 
 
 

 1.3.1 Install new objects and upgrade/create a repository 

This procedure performs the following actions: 
- Copy the objects from the container file and install them in the correct object-location. 
- Do the necessary data conversions in the repository.  
- Load the new screens and messages in the repository (these are used by the mainframe software). 

 
Read document “Installation of SURE.doc” to obtain detailed information about the installation procedure. 
 
Log on to Cande with a usercode that is equal to the usercode of the repository that you want to create or 
upgrade (So, if you want to create/upgrade a repository under usercode XYZ then log on to Cande with usercode 
XYZ). 
 
The MCP software is delivered via a wrapped and zipped container file: 

- The name of the container file contains the MCP version and the SURE version: 
o For example: container file SURE110MCP631 contains the SURE objects of release 110 that run 

on the MCP. The objects are compiled with MCP-63.1 compilers with a DMS-63.1 version of the 
INFDB-description file.  

 
- Choose the correct containerfile based on your current MCP level.  

o If your current MCP level is 59.1 or 60.1 then use container file SURE110MCP601. 
o If your current MCP level is 62.1 or 63.1 then use container file SURE110MCP631. 

 
- The container file must be downloaded from the Internet.  
- File transfer the container file to the mainframe with binary FTP. 
- Unwrap the container file with restriction = false. The files are placed on disk under usercode INFRA. 

 
Start the installation as follows: 

- DO (INFRA)RESPECT/SETUP ON <install-pack>(“<installation-pack>(PACK)”) 
 
The installation procedure is well described in the installation document.  
 
RESPECT/SETUP initiates the installation program where the following questions have to be answered: 

- Do you want to install a new repository or upgrade an existing repository? 
- What objects do you want to install: the RESPECT software, the SURE Explorer interface or both? 
- Where do you want to install the objects? 
- What are the database family, the dmsupport family and the auditfile family? 
- What is your current DMSII release level? 
- What is the repository environment? 

 
If you currently use release 80: read paragraph Task-0272-SURE in the notes of release 90 for the detailed steps 
how to upgrade your repository from 80.x to release 90.6 and then further. 
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 1.4 Compatibility 

Refer to the list of frequently asked questions on our website www.itsforsure.nl for the last remarks about 
compatibility. 
 
 
 

 1.4.1 Database compatibility 

The Download Website contains two wrapped container files with SURE mainframe software.  
The only difference between these three container files is that the software is compiled with different versions of 
the ALGOL compiler and different versions of the INFDB description file. 
The layout of database INFDB has not changed since December 2001. The only difference between the 
description file versions is that they are compiled with different versions of the DASDL compiler. 
 

Container file Compilers DESCRIPTION/INFDB 

SURE110MCP601 MCP 601 DMALGOL compilers Created with DASDL compiler of MCP 601 
SURE110MCP631 MCP 631 DMALGOL compilers Created with DASDL compiler of MCP 631 
   

 
We upgrade the original INFDB description file for each MCP release and keep the upgraded description file as 
RELEASE/DESCRIPTION/INFDB/INFRA/DMSxx 
This sequence of original description files is also added to the release container file: 

LFILE (INFRA)RELEASE/DESCRIPTION: RELEASEID            
#RUNNING 6936                                           
#?                                                      
ON IDRD                                                 
(INFRA): DIRECTORY                                     
. RELEASE: DIRECTORY                                   
. . DESCRIPTION: DIRECTORY                             
. . . INFDB: DIRECTORY                                 
. . . . INFRA: DIRECTORY                               
. . . . . DMS60 : DASDLDATA RELEASEID="INFDB_2_DMS601" 
. . . . . DMS62 : DASDLDATA RELEASEID="INFDB_2_DMS621" 
. . . . . DMS63 : DASDLDATA RELEASEID="INFDB_2_DMS631" 

 
Example 

- Container file SURE110MCP601 contains SURE software that is compiled with a DMS-60 version of the 
description file. To run this software it is required that your INFDB is upgraded to DMS level 60.1 or 61.1  

 
- The layout of the INFDB has not changed, so there is no database reorganization required. That means 

that an object which is compiled against the DMS-60 version of the description file, still runs when the 
database is upgraded to level 61. 

 
If you did intermediate database updates (for example to change packnames or areasizes of datasets), then 
newly delivered SURE software may fail with DMS-VERSIONERROR when you run it. In that case, it is necessary to 
do a ‘dummy’ database upgrade of your INFDB to make your database available for our newly compiled 
software. Refer to the SURE manual chapter 9.2.3 ‘(installation) SURE objects and database compatibility’ for a 
detailed explanation why you get the version error and how to fix this. 
 
 

 1.4.2 Compatibility with MCP releases 

No compatibility issues were found. 
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 1.4.3 Compatibility with previous SURE releases 

The software consists of the following parts: 
1. SURE client software 
2. The SURE server on the mainframe 
3. Other SURE mainframe software (libraries and batch programs) 

 
The release number of your installed software is found in the SURE GUI, via toolbar → help → about:  

  
 
 The above example screen shows two release numbers: 

- The release number of the MCP software (110.1 compiled on Aug 18, 2023, at 22h00) 
- The release number of the client software (110.1 built on Aug 21, 2023, at 16h37) 

 
 
Both release numbers (MCP and client) consist of three parts: 

1. The major release number (in this case 110) 
o We do not do any database reorganization or any data conversion inside the repository as long 

as the major release number remains the same. 
o There can be a database reorganization or data conversion between two major releases. 

2. The minor release number (in this case 1) 
o The minor release number guards the compatibility between the client and server within a 

major release.  
▪ Sometimes we must make a modification on the client side and on the server side to 

solve an issue, and then we upgrade the minor release number. 
▪ In other cases, we only have to modify something on the client side or on the 

mainframe side, and then the minor release number is not raised. 
3. The compile/build timestamp. 

o The timestamps are the moments of the compilation of the mainframe software and the 
building of the client software. 

 
 
Compatibility of the Client software: 
The SURE client is only compatible with the SURE server on the mainframe if the major release number and the 
minor release number are equal. 
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Example 
SURE client  SURE server Compatibility 
110.1 100.3 No, because the major release number is different. 
110.1 110.0 Partly, because the minor release number is different. Most functionality 

will still work but the interface layout of some functions is changed. 
110.1 110.1 Yes. 

 
 
Compatibility of the Mainframe software: 
SURE on the mainframe consists of three parts: 

- Database INFDB  
- The SURE server OBJECT/RIS/API/= 
- SURE libraries and batch programs OBJECT/RESPECT/= and OBJECT/RIS/=  

 
The following compatibility rules apply: 

- A 100 style INFDB is compatible with the 100.x libraries and batch programs. 
- A 110-style INFDB is compatible with the 110.x libraries and batch programs. 
- The 110.x SURE server is compatible with the 110.x and 100.x libraries and batch programs 
- The 110.x SURE server is only compatible with the 110.x SUREforWindows GUI. 

 

 
 
The style of database INFDB is set by program RESPECT/REPOSITORY ("UPGRADE-REPOSITORY").  

- Do not run this program when release 110 is installed temporarily as pilot for some test users. 
- Run this program when release 110 is installed permanently for all users. 
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 1.4.4 Compatibility with Windows versions 

The SURE client is tested under Windows-8, Windows-10, and Windows-11. 
The SURE client configured as SURE build server is tested under Windows Server 2008, 2012, 2016, 2022 and 
2025 
 
No compatibility issues were found. 
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 1.5 Upgrading the SURE software to release 110.x 

There are several ways to upgrade to a newer release. Read the installation manual for details. The preferred 
method is as follows:  
 
Upgrading the SURE server software and the repository: 

- ?DISABLE the SURE Explorer interface on the mainframe. 
- Install the new SURE Explorer interface software on the mainframe under the same usercode and with 

the same port-number as where the old SURE Explorer interface software is resident. This overwrites 
the old SURE Explorer interface on the mainframe.  

- Install the new general objects and upgrade database INFDB to style 110 using the installation job 
WFL/RIS/INSTALL. 

 
Upgrading the SURE client software: 

- Install the new client software on each workstation with an upgrade installation. This overwrites the old 
client software on the workstation. 

- When all workstations are upgraded: ?ENABLE the SURE Explorer interface on the mainframe. 
 
 

 1.5.1 Automatic upgrade feature of the client software. 

The automatic upgrade feature of the client software checks the current version of the client software with the 
available version of the client software. If both versions are not the same, an installation screen is presented.  
 
Detailed information 
Updating the SURE client software may require effort when having a large network. For this reason, SURE 
supports multiple styles of installation: 

a) Local client installation on each applicable workstation 
b) Server based installation with personalized options 
c) Full server installation. 

 
Server installations (options b and c) 
In the case of a server installation, the SURE client software is placed on a central server that is accessed by the 
workstations of the developers. Because of this central installation, a software update is reasonable easy to 
install for the first time. Upgrading a server installation to a newer SURE release requires a few extra steps.  
The tradeoff for a server installation is that the network throughput must be sufficient (100KBS). It does not 
support wide area networks with a low bandwidth.  
 
Local client installations (option a) 
In the case of a local client installation, the SURE-PC-software is placed on the workstation of a developer. 
Installing the SURE PC-software as a local client is quite easy for initial and upgrading installations. 
The tradeoff is that it is difficult to synchronize the upgrade to a newer SURE release when the SURE client 
software is installed locally at many workstations. 
 
Solution 
SURE can check the version of the PC-software at logon time and may initiate a local client installation. This 
combines the benefits of easy local client installation with the benefits of a synchronized server installation.  
 

Example 
The following dialog is shown after logon when the versions of the installed client release and the available 
release for the client do not match. 
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This example screen describes the following situation: 

o The version number of the SURE server on the MCP is 110.1, built on August 18, 2023. 
o The version number of the ‘available’ SURE PC software is 110.1, built on September 5, 2023 
o The version number of the client software that is now installed on this workstation is 100.4. 
o So, in this case the SURE server software has already been upgraded to version 110.1 and the 

client software is still of the old release but can be upgraded via the ‘available’ client version. 
 
Click OK to start the installation. This installs the available client software. 
 
Click ‘Cancel’ to skip the installation, however the same message is then issued after the next logon.  

- A plausible reason to skip the automatic installation is for example when the developer works at home 
via a slow internet connection, and he does not want to upgrade his SURE-GUI via that slow connection. 
A solution is to upgrade the SURE-GUI later when he has a fast connection to the location where the 
new SURE-Client software is placed. 

- It is possible to use a SURE client that has another software version number than the SURE Server 
software, but some actions may issue an unexpected error message. 

 
 
The release number of your installed software is found in the SURE GUI, via toolbar → help → about:  
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 The above example screen shows two release numbers: 

- The release number of the MCP software (110.1 compiled on Aug 18, 2023, at 22h00) 
- The release number of the client software (110.1 built on Aug 21, 2023, at 16h37) 

 
 
Both release numbers (MCP and client) consist of three parts: 

4. The major release number (in this case 110) 
o We do not do any database reorganization or any data conversion inside the repository as long 

as the major release number remains the same. 
o There can be a database reorganization or data conversion between two major releases. 

5. The minor release number (in this case 1) 
o The minor release number guards the compatibility between the client and server within a 

major release.  
▪ Sometimes we must make a modification on the client side and on the server side to 

solve an issue, and then we upgrade the minor release number. 
▪ In other cases, we only have to modify something on the client side or on the 

mainframe side, and then the minor release number is not raised. 
6. The compile/build timestamp. 

o The timestamps are the moments of the compilation of the mainframe software and the 
building of the client software. 

 
 

Technical details and considerations 
The following procedure is required to trigger the automatic client installation. 
 
The delivered SURE software package contains the SURE CP/NX modules and the SURE client modules. The two 
modules are compatible and have the same version number. 
 
The entire installation consists of three steps: 

1. Copy the new version of the SURE CP/NX software to the correct location on the mainframe. 
 

2. Define the location of the available client software in SURE: 
Global Options → field ‘installation location’ 
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The location of the available client software is in this example: 
 U:\Build\RIS_100\Release 

 
3. Copy the new version of the SURE-PC-software to that location: 

 
 
In this example, the SURE client software is available in directory ‘U:\Build\RIS_100\Release\’  
 This directory contains three files that control the version number of the release: 

- Release.ini 
o The number in this file defines the first part of the software version. This number is raised by 

one with every major release (about 1 time per two years). 
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- Format.ini  
o The number in this file defines the middle part of the software version number. This number is 

raised by one if the layout of the interface between client and server is changed. 
- Build.ini 

o The date in this file defines the last part of the software version number. It is the build date of 
the software. 

 
If any of the three files (step 3) is missing, or if the installed location (step 2) is not defined, then the automatic 
upgrade dialog is skipped. 
 
 

 1.5.2 Multiple installations of the SURE client on one workstation 

It is possible to install multiple instances of SUREforWindows on one PC. Information about each 
SUREforWindows installation is kept in file RFW.INI in directory C:\ProgramData\ITSforSURE\. 
 
The following example RFW.INI file contains information about two installations: an installation for the ‘REND’ 
repository and an installation for a ‘DEMO’ repository. 

[GLOBAL] 

APPLICATION1=SURE for Windows\REND 

APPLICATION2=SURE for Windows\DEMO 

 

[SURE for Windows\REND] 

SETUP=SURE 

DIRECTORY=C:\SURE\REND 

INSTALLED3=SURE,100.4.0,BASE,DOCS 

 

[SURE for Windows\DEMO] 

SETUP=SURE 

DIRECTORY=C:\SURE\DEMO 

INSTALLED3=SURE,110.1.0,BASE,DOCS 

 
Each instance of the SURE client should be installed in a separate directory. 
In this example: 

- The SURE client for the REND repository is installed in directory C:\SURE\REND\. 
- The SURE client for the DEMO repository is installed in directory C:\SURE\DEMO\. 

 
Multiple SURE clients in combination with the automatic upgrade feature 
When a SURE client is installed for the first time on a workstation, the installation process asks for a program 
folder name. This program folder name is used for four purposes: 

- Create a program folder in the Windows startup menu. 
- This name becomes the title of the SUREforWindows client (in the title bar). 
- This name is placed in the AW_OBJ.INI file ([global]title). 
- This name is used as a key for the RFW.INI file. 

The automatic installation searches for an application with the program folder name in the RFW.INI file. If the 
program folder name is not found in the RFW.INI file, then the automatic installation is aborted with an error 
message. If the program folder name is found, then the software is installed in the directory that is defined for 
the program folder name. 
 
Example 
A user starts ‘SURE for Windows\DEMO’ and logs on. An automatic installation is required, and the user clicks on 
the OK button to start it. The automatic installation is started with parameter ‘SURE for Windows\DEMO’ . The 
automatic installation process opens the RFW.INI file and searches for application ‘SURE for Windows\DEMO’ . If 
that application is found, then the software is installed in the directory that is defined in paragraph [SURE for 
Windows\DEMO]. This is directory C:\SURE\DEMO. 
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 1.5.3 About SURE release numbers 

The release number of your installed software is found in the SURE GUI, via toolbar → help → about:  

  
 
 The above example screen shows two release numbers: 

- The release number of the MCP software (110.1 compiled on Aug 18, 2023, at 22h00) 
- The release number of the client software (110.1 built on Aug 21, 2023, at 16h37) 

 
 
Both release numbers (MCP and client) consist of three parts: 

7. The major release number (in this case 110) 
o We do not do any database reorganization or any data conversion inside the repository as long 

as the major release number remains the same. 
o There can be a database reorganization or data conversion between two major releases. 

8. The minor release number (in this case 1) 
o The minor release number guards the compatibility between the client and server within a 

major release.  
▪ Sometimes we must make a modification on the client side and on the server side to 

solve an issue, and then we upgrade the minor release number. 
▪ In other cases, we only have to modify something on the client side or on the 

mainframe side, and then the minor release number is not raised. 
9. The compile/build timestamp. 

o The timestamps are the moments of the compilation of the mainframe software and the build 
of the client software. 

 
 
The About screen shows also: 

- The current MCP release. In this example: MCP 60.1 
- The Windows-releases of the workstations where the SUREforWindows GUI was used during the last 

month. In this example: 1 time Windows-7, 1 time Windows-8, 3 times Windows-10. 
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 2 Features and improvements 
 
 
A full list of all tasks that are completed during this release can be found at the end of this document. 
 
 
 

 2.1 Detailed descriptions of the most important new features, release 110.x 

This chapter gives examples and details about the most important new features that were completed during this 
release. 
The following information is given per task: 

- Task description + detailed description 
o This describes the new feature plus the reason why the feature was implemented. 

- Examples 
- Optional: Technical details and considerations 

o This describes compatibility issues and gives tips and hints. 
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 Task-1573-SURE Define Help-information for the screens under folder Datamodel 

All screens under folder Datamodel now have a [Help] button in the right upper corner of the screen 
 
Pressing [Help] gives information about all fields on the screen 
 
Example 
 
Right click on folder ‘Transaction’ → Refresh, gives the screen to select transactions: 

 
 
Button [Help] gives the help information of function ‘Select transaction’ 
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 Task-1602-SURE Update properties: keep a log of the changes  

SURE now keeps for each file a log of the properties that were changed via function Modify Properties. 
This log is never cleaned. 
 
The log is visible via function: right click on the file → Miscellaneous → Update history 
 

  
- The log shows the old and new value for each changed attribute 

 
- The log can be printed via button [Print] 

 
 
For RIS-users: 

- If the properties of a RIS-module are changed then those changes are also logged, similar to how the 
changed file properties are logged.  

- The log is visible via function: right click on RIS module → Update history 
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 Task-1606-SURE Extra events in the SURE log when a task is transferred  

SURE generates extra events in the SURE log when a task is transferred. The events can be intercepted in the 
SURE event library to create detailed overviews about the task transfer. 
 
Using the additional log events, the following situations can be identified in the SURE event library: 

- Multiple users can transfer tasks at the same time 
- The transferred task can be a release task (or master task) containing multiple sub tasks 

 
The following events are now passed to the Event Library when a task, a master task or a group of tasks is 
transferred 
 
At the beginning of the transfer session: 
   Call SITE_EVENT with: 
        owner = <empty> 
       ,class = LOGUSER 
       ,prog = "Xfer" 
       ,func = "Transfer" 
       ,environment = <destination-environment> 
       ,task = <empty> 
       ,group = PROBLEM 
       ,user = <user-id> 
       ,text = BEGIN-SESSION 
 
At the beginning of a task: 
   Call SITE_EVENT with: 
        owner = <task-name> 
       ,class = LOGUSER 
       ,prog = "Xfer" 
       ,func = "Transfer" 
       ,environment = <destination-environment> 
       ,task = <task-name> 
       ,group = PROBLEM 
       ,user = <user-id> 
       ,text = BEGIN-TASK 
 
For each file or RIS-module  (this event existed already and is also logged): 
   Call SITE_EVENT with: 
        owner = <file or RIS-module> 
       ,class = LOGUSER 
       ,prog = "Transfer" 
       ,func = "Transfer" 
       ,environment = <destination-environment> 
       ,task = <task-name> 
       ,group = FILE-CONTROL  or <RIS-module>-CONTROL 
       ,user = <user-id> 
       ,text = <variable text>  
 
At the end of a task: 
   Call SITE_EVENT with: 
        owner = <task-name> 
       ,class = LOGUSER 
       ,prog = "Xfer" 
       ,func = "Transfer" 
       ,environment = <destination-environment> 
       ,task = <task-name> 
       ,group = PROBLEM 
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       ,user = <user-id> 
       ,text = END-TASK  <number of files and RIS-modules that were transferred for this task> 
 
At the very end of the transfer session: 
   Call SITE_EVENT with: 
        owner = <empty> 
       ,class = LOGUSER 
       ,prog = "Xfer" 
       ,func = "Transfer" 
       ,environment = <destination-environment> 
       ,task = <empty> 
       ,group = PROBLEM 
       ,user = <user-id> 
       ,text = END-SESSION  <total number of files and RIS-modules that were transferred during this session> 
 
 
The flow is as follows: 
 

1. The transfer session starts always with an event with PROG = “Xfer” and TEXT = “BEGIN-SESSION” 
- Parameter USER gives the user who started the transfer session 

 
2. A transfer of a task starts with an event with PROG = “Xfer” and TEXT = “BEGIN-TASK” and USER = <user 

of step 1> 
- Parameter OWNER gives the task name 
- Parameter TASK also gives the task name 

 
3. A transfer of a file or RIS-module has an event with PROG = “Transfer” and FUNCTION = “Transfer” and 

TASK = <task of step 2> and USER = <user of step 1> 
- Parameter OWNER gives the filename or RIS-module 
- Parameter TASK gives the task name 
- Parameter GROUP is “FILE-CONTROL” in case of a file, and otherwise <RIS-module>-CONTROL 

 
4. A transfer of a task ends with an event with PROG = “Xfer” and TEXT = “END-TASK” and USER = <user of 

step 1> 
- Parameter OWNER gives the task name 
- Parameter TASK also gives the task name 
- END-TASK is followed by the number of files and RIS-modules that were transferred for this task 

 
5. The transfer session ends always with an event with PROG = “Xfer” and TEXT = “END-SESSION” and 

USER = <user of step 1> 
- END-TASK is followed by the total number of files and RIS-modules that were transferred during this 

session 
 
 
The check on USER is necessary because multiple users can do a task-transfer at the same time. 
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 Task-1630-SURE Make each batch function only visible for users with right privileges 

The list of batch functions is filtered based on the user's privileges. 
 
The list of batch functions is opened via function Toolbar → Tools → Server environment → Batch functions 
 
A batch function can be linked to an employee function, to make that batch function visible for all users with that 
role. This makes it possible to hide batch functions for certain users and to make them visible for other users. 
Each user has his own list with available batch functions. 
 
Example: 

 
In this example: Batch function SELECT-UNUSED is visible for all users with employee-function SENIOR 

 
The following filters apply: 

1. Batch functions that have anything to do with users, teams, or the authorization mechanism of SURE are 
visible for: 

a. If one or more users are defined as security administrators: the Security administrators. 
b. If no user is defined as security administrator: the users with privilege ‘Global: Securities’ 

2. The other batch functions are visible for: 
a. The users with privilege ‘Global: SURE maintenance’ can see all other batch functions 
b. Users without privilege ‘Global: SURE maintenance’ can only see the batch functions that are 

linked to one of their roles. 
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 Task-1636-SURE New method to handle the parameters of batch programs  

Sometimes a batch program needs an input parameter in lowercase.  
 
The old method: a token of an input parameter was automatically translated to uppercase if it was completely 
written in lowercase.  
The new method: if a token is surrounded with extra single quotes, then it is not translated to uppercase. The 
surrounding quotes are automatically removed from the token. 
 
Example  
 
RUN RESPECT/REPOSITORY("TOKEN1   Token2   token3   'token4' "); 
 

- TOKEN1 is already in uppercase. 
 

- Token2 is in mixed case, so it will not be translated to uppercase. 
 

- token3 is completely in lowercase and has no surrounding single quotes, so it will be translated to 
uppercase. 
 

- 'token4' is completely in lowercase and has surrounding single quotes, so it remains lowercase, and the 
quotes are removed. 
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 Task-1662-SURE Define a default project and file-type for a directory 

It is now possible to define a default project and file-type for a directory. When a new file is added to the 
directory then the defaults are pre-filled on screen ‘Add new File’. 
 
File-type and project are important in SURE because these file attributes determine how a source is compiled, 
and where the object is placed.  
 
When a new source is added to SURE then it must get the correct file-type and project to improve a smooth 
introduction of the program in the run time environment. 
 
Define the default attributes as follows: 

- Right click on a directory → Set defaults for new files 

 
Field Example 

screen 
Explanation 

Directory S/BA/ALP The directory that was right clicked 
Current project  The current setting of the default project for this directory 
Current file type ALP The current setting of the default file-type for this directory 
Inherits from S/BA The spanning directory from which the defaults can be inherited 
Inherited project BA The inherited default project for this directory 
Inherited file type  The inherited default file-type for this directory 

 
- In this example: 

o A default project BA is defined for directory S/BA and inherited by S/BA/ALP. 
o A default file-type ALP is defined for directory S/BA/ALP. 
o So, directory S/BA/ALP has default project BA and default file-type ALP. 

 
It is possible to define defaults for a directory and to define other defaults for a subdirectory.  
 



SURE Release 110 

Releasenotes110.docx 22  

Enter a new MCP file via: Right click on an MCP directory → New MCP file 

 
 
Enter a new PC file via: Right click on a PC directory → New PC file 

 
 
In both cases: 

- The name of the directory is prefilled; you only have to complete that to the name of the file that must 
be added.  

- The default project and file-type of the directory are prefilled on the screen. 
- You still have the option to change the defaults. 

 
SURE gives a warning if a new file is added with a file-type or project that differs from the default. You then have 
the option to correct the input and use the default values, or to ignore the warning and add the file with 
deviating attributes. 
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 Task-1670-SURE Review support for MCP data files that are loaded in SURE 

MCP data files can be loaded in SURE. 
 
An MCP data file can be copied from SURE to the Windows platform with two different layouts: 

- A carriage return plus line feed is placed behind each record in the local work file, so each record 
becomes a separate line in the local editor. 

- All records in the data file are not separated by a CR/LF. The records are placed in the local work file 
behind each other as one long stream of data. 

 
 

Check-out/Check-in MCP data file 
The behavior of these functions depends on the options Local Editing’ and ‘Insert CR/LF’ 

 
 
In case of a multi check-out the options apply for all data files that are selected. 
 
If ‘Local Editing’ is disabled: 

- At check-out, the data file is placed in the users Cande directory with the same record size as how the 
file was previously loaded or checked in. 

- The file can be modified via the Cande editor, or via Programmers Workbench, or via a program.  
- In this mode it is also possible to change the record size of the data file. 
- At check-in, the changed file is saved in SURE with its (changed) record size. 

 
If ‘Local Editing’ is enabled and 'Insert CR/LF' enabled: 

- At check-out, the data file is always copied from SURE to the local work directory on Windows. 

- A carriage return plus line feed is placed behind each record in the local work file, so each record 
becomes a separate line in the local editor. 

- The trailing spaces of the records are removed. 

- At check-in: 
o The CR/LF characters at the end of the lines are removed, and the data file is saved in SURE 

with the original record size.  
o In this mode it is not possible to change the record size.  
o Lines that are shorter than the original record size are filled up with spaces.  
o Lines that are longer than the original record size are split and become two lines of that size.  

 
If ‘Local Editing’ is enabled and 'Insert CR/LF' is disabled: 

- At check-out, the data file is always copied from SURE to the local work directory on Windows. 

- The trailing spaces of the records are not removed, so each record keeps it original size. 

- All records in the data file are not separated by a CR/LF. The records are placed in the local work file 
behind each other as one long stream of data. 

- At check-in:  
o The data file can only be checked-in if the total file size is a multiple of the original record size.  
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o The data file is split into records; each record has the original record size. 
o In this mode it is not possible to change the record size.  

 
 

View MCP data file 
This function copies the file from SURE to the local source directory on Windows. 

- Right click on the data file in SURE → View or Get Latest Version 
 
SURE asks how the file must be downloaded: as a text file (with CR/LF behind each record) or not: 

 
 
 

Download MCP data file 
This function copies a file from the users Cande location to the download folder on Windows. 

- Folder SURE Server → Sources → Right click on the destination directory → Download 
 
SURE asks how the file must be downloaded: as a text file (with CR/LF behind each record) or not: 

 
 
 

Upload MCP data file 
This function copies a file from the download folder on Windows to the users Cande location. 

- Folder SURE Server → Sources → Right click on the destination directory → Upload file 
 
SURE asks if the file on the Windows platform a text file is (with CR/LF behind each record) or not: 

 
 
The user must enter the record size: 
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If the file is not a text file (with CR/LF behind each record) then the total file size must be a multiple of the record 
size. 
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 Task-1673-SURE Show the review status on the task forms 

The task form reports show review information about the linked files. 
 
Example 
 

 
 
This is done for the following reports: 

Toolbar → Reports 
o Task forms (selection via a highlighted Macro) 
o Task forms (selected tasks in browser) 
o Task details form (of selected task in browser) 
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 Task-1676-SURE Implement SURE Find in delta files  

It is now possible to search through the delta files of a source. For example when you want to know what 
happened with a specific variable during a period. 
 
You can only use this function for one source per scan. 
 
To start with the SURE find in the delta files: 
 Expand the file-folder → Right click on folder ‘Delta Files’ → Find 

 
 
Add the tokens to the find table and start the scan: 

 
The find table of this example contains 1 token: OWNER_COMPILE_STATUS 

 
Open the find listing  

-  
- Press [Show report]  
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The find listing: 

 
 

- The listing starts with an overview of where the token is used in the current source. 
 
- It continues with the lines where the token appears in the delta files.  

o For each delta file the task name is printed. This should explain the reason for the change 
o For each line in the delta file: the full line which includes the mark-id with the initials of the 

developer, plus an indication if the line was added or deleted. 
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 Task-1679-SURE Change the background color of the SURE browser 

The background color of the SURE browse has always been 'bright white'. During the COVID period, where many 
developers worked from home, we received several questions about whether it was possible to change the 
background color. 
 
It is now possible to change the background color via the following option: 

- Click on Toolbar → Options → SURE Options → Field ‘browse color scheme’  
- Restart the SURE client when you changed the color scheme. 

 
Browse color scheme supports the following pre-defined background colors: 
 

Normal 
 
The old color scheme that we all 
know. 
 

 
 

Dim 
 
There is now a grey filter over the 
entire window, so all colors are a 
bit grey. 

- White is light grey 
- Black is dark grey 
- Blue is blue-grey 

The colors of the icons remain 
unchanged. 
 
 

 
 



SURE Release 110 

Releasenotes110.docx 30  

Inverse 
 
Each color is translated to its 
reversed value: 

- Black to white 
- White to black 
- Blue to yellow 
- Et cetera 

 
The colors of the icons remain 
unchanged. 
 
 

 
 

Grayscale 
 
Each color is translated to its 
corresponding grayscale. 

- White remains white 
- Black remains black 
- Blue becomes grey 

 
For example: the task description 
now has a grey color. 
 
The colors of the icons remain 
unchanged. 
 

 
 

 
 
The colors of the pop-up screens are not changed. 
 
  



SURE Release 110 

Releasenotes110.docx 31  

 Task-1681-SURE Function Select file: allow to enter a directory name  

It is now possible to select all files of a directory and its sub directories 
 
 
Function Select File: Enter the directory name, followed by a slash or backslash 

 
 
All files of that directory and its dub directories are selected: 

-  
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 Task-1690-SURE Use ClearPath Visual IDE as editor for MCP sources 

Unisys ClearPath Visual IDE (CV-IDE) is a plugin for Microsoft Visual Studio 2017 or Microsoft Visual Studio 2019 
to provide an integrated development environment to developers for creating projects, editing MCP symbol files, 
and building solutions using the familiar Visual Studio interface as they already use for C#, C++, ePortal, Agile 
Business Suite, and other languages. 
 
It is possible to use CV-IDE in combination with SURE. The key features are: 

- When an MCP file is checked out from SURE, that file is automatically opened in Visual Studio/CV-IDE. 

- Compiling an MCP file from CV-IDE uses the compiler settings of that file as defined in SURE. 
 
CV-IDE is a plugin for Microsoft Visual Studio for modifying MCP files. Visual Studio requires a solution file and 
project file, so using Visual Studio means that those files must be present.  
 
If CV-IDE is defined in SURE as editor for MCP files, then the solution and project file are automatically created by 
SURE when an MCP file is checked out. SURE creates the solution and project file based on predefined templates. 
 
The interface between SURE and CV-IDE work as follows: 
 

SURE Function 
 

Behavior 

Check Out 
 

The source file is checked out and copied as MCP work file from SURE to the users Cande 
work location. 
 
The MCP work file is then copied from Cande to the workspace for Visual Studio as local 
‘xxx_m’ work file (xxx_m is the file extension, where xxx depends on the filekind). Each 
local work file has its own separate workspace for Visual Studio. This file is a 
“placeholder”, it must be present, but changes in this local work file are automatically 
synchronized with the Cande work file by the Visual Studio CV-IDE plugin. 
 
SURE creates a solution file and a project file, both in the same workspace as the local 
work file. 
 
If “Edit/Open” is selected, the solution file is opened in Visual Studio/CV-IDE, and the 
local work file is shown in its editor window. 
 
 
 

Edit 
 

This function is only available if the file is already checked-out. 
The solution file is opened in Visual Studio/CV-IDE, and the local work file is shown in its 
editor window.  
 
 
 

Local Compile 
 

The developer can start a local compile from Visual Studio/CV-IDE.  
If the build type in Visual Studio/CV-IDE is set to ‘Custom build’, then the compilation is 
executed by SURE job WFL/<environment>/COMPILE. This job uses the compilation 
parameters that are defined for the file in SURE, which includes binding, a deviating 
object name, a user defined post compilation process, et cetera. 
Read paragraph ‘Local Compile started from Visual Studio/CV-IDE’ details about the Build 
Type.  
 
 
 

Check In 
 

If the ini file (AW_OBJ.INI) contains option [CVIDE]CHECK=<lock file>, then SURE gives an 
error message if the local work file is still open in Visual Studio. The local work file must 
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be saved in Visual Studio, and the solution must be closed, so that the MCP work file is 
certain to be synchronized with the local work file.  
 
The MCP work file is saved in SURE and removed from Cande. 
 
If the ini file (AW_OBJ.INI) contains option [CVIDE]REMOVE=<subdir>, then the local files 
in this directory are removed. Currently, this option should be REMOVE=.vs, as this .vs 
subdirectory of the workspace directory is created by Visual Studio/CV-IDE itself and 
contains a temporary file cache that can safely be removed along with the workspace. 
 
 
 

Undo Checkout 
 

If the ini file (AW_OBJ.INI) contains option [CVIDE]CHECK=<lock file>, then SURE gives an 
error message if the file is still open in Visual Studio. 
 
The MCP work file is removed from Cande. 
 
If the ini file (AW_OBJ.INI) contains option [CVIDE]REMOVE=<subdir>, then the local files 
in this directory are removed. 
 

 
 

Configuration 
Using CV-IDE in combination with SURE requires that templates for the Solution and Project files for Visual Studio 
be loaded in SURE. Once the templates are loaded in SURE they are available for all users and all MCP files. Read 
paragraph ‘Templates for Solution and Project files’ for details how to load the templates. 
 
Each developer who wants to use CV-IDE must set the following local options via function: 
   Toolbar → Options → SURE options: 

1. Enable SURE GUI option ‘Use CV-IDE to edit MCP files’ 
2. Define the Base Project Directory for CV-IDE via field ‘MCP NxEdit/CV-IDE’ 

 
o About the project directory: read paragraph ‘Workspace for Visual Studio’ for details. 
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Workspace for Visual Studio 
When a file is checked out, SURE creates a separate working environment for that file for Visual Studio. This 
separate workspace is a subdirectory of the Project Directory. The Project Directory is defined via Toolbar → 
Options → SURE options → field MCP NxEdit/CV-IDE.  
 
The full name of the Visual Studio workspace of a file is: <Project Directory>/<file name> 
 
Example 
Suppose the Project Directory is defined as C:\SURE\TESTATV\DEVELOP\PROJECT, and Cobol85 file SIM/PS/X100 
is checked out:  
 

 
- The base project directory is C:\SURE\TESTATV\DEVELOP\PROJECT 
- The file name is SIM/PS/X100, so the subdirectory is SIM\PS\X100. 
- The Visual Studio workspace for this file: C:\SURE\TESTATV\DEVELOP\PROJECT\SIM\PS\X100 

 
- The following files are created by SURE, based on the last node of the file name: 

The solution file: X100.sln 
The project file: X100.mcpproj 
The local work file: X100.c85_m 

 
Visual Studio creates additional files in the workspace when the solution is opened.  
 
 
 

Local compile started from Visual Studio/CVIDE 
 
When you are logged on to Cande, you have 2 options to compile a program: 

1. Via Cande command COMPILE 
- This command only compiles the source 
- The default object name is OBJECT/<source-name>  (unless you use COMPILE AS) 
- The object is created under your usercode 

2. Via a job: 
- The main difference with the Cande COMPILE command is that a job can do extra things.  

 
CVIDE offers two similar build types to compile a program: Default Build or Custom Build 
 
Default Build is like the Cande COMPILE command: 

- The object is created under your Cande usercode 
 
Custom Build is like a Cande compile-via-job: 

- SURE creates a CVIDE project file that uses compile job WFL/<environment>/COMPILE.  
This job does the following: 

o  
o If the compiled object must be bound into a driver, then start the binder 
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o If the compiled object must be marked with special MP commands (like PU, TASKING, 
EXECUTABLE, et cetera) then do that. 

o If the compiled object must have a deviating name, then give it that deviating name 
o If the compiled object must be copied to another location, then do that. 

 
A developer can switch between Default Build and Custom Build via the project properties in Visual Studio. 
 
The Build Type in the CVIDE project file (that is created by SURE at check-out) is determined by SURE based on 
the filekind of the source and the defined build type in SURE. 

- If the filekind of the source is COBOL, COBOL74 , COBOL85, ALGOL, DMALGOL, or DCALGOL:  
o If the CVIDE templates are loaded in SURE with option DEFAULT-BUILD, then the build type in 

the CVIDE project file is ‘Default’ 
o If the CVIDE templates are loaded in SURE with option CUSTOM-BUILD, then the build type in 

the CVIDE project file is ‘Custom’ 
- If the filekind of the source is not COBOL, COBOL74 , COBOL85, ALGOL, DMALGOL, or DCALGOL then the 

build type in the CVIDE project file is always ‘Default’ 
 
 
 

Options in the AW_OBJ.INI file 
The following options can be defined in the AW_OBJ.INI file to improve the integration between CV-IDE and 
SURE: 

[CVIDE] 

REMOVE=.vs 

CHECK=.vs\<LASTNODE>\FileContentIndex\read.lock 

 

 

Option [CVIDE]REMOVE=<name of subdirectory> 
The purpose of this option is to remove the Visual Studio workspace of the file after the file is checked in or when 
undo checkout is used, to keep the base project directory clean. 
 
By default, the Visual Studio/CV-IDE workspace is not removed when a file is checked in. 
 
Notice that all files in the workspace are temporary files and can be removed if the file is not in maintenance: 

- The solution and project files are based on templates and will be (re)created at check out. 
- The local work file is a copy of the MCP source that is checked out from SURE and placed in the user’s 

Cande work environment: (<usercode>) ON <work pack>. If the local work file is lost, it can be recreated 
via CV-IDE from the MCP source. 

- All other files are (re)created by Visual Studio when they are lost.  
- Version 17 of Visual Studio creates these other files in subdirectory .vs  

 
 
If this option is enabled, then the behavior at check-in is the same as when CV-IDE is not used. 
 
If CV-IDE is not used the behavior is as follows:  

- At check out: the file is copied from SURE to Cande. 
- At check-in: the MCP work file is saved in SURE and removed from Cande. 

 
If CV-IDE is used the following happens: 
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- At check out:  
o The file is copied from SURE to Cande  
o The MCP work file is then copied from Cande to the workspace for Visual Studio as local 

‘xxx_m’ work file (xxx_m is the file extension, where xxx depends on the filekind). 
o The solution and project files are created and copied to the workspace. 

- At check-in: 
o The local work file must first be saved in Visual Studio, to synchronize the MCP work file with 

the local work file. 
o The MCP work file is saved in SURE and removed from Cande.  
o If option [CVIDE]REMOVE=<subdirectory> is defined, then the following files are removed: 

▪ The solution and project files. 
▪ The local ‘xxx_m’ work file. 
▪ The <subdirectory> and all files in that subdirectory. 
▪ If the workspace is completely empty, then the workspace directory is removed too. 

o If (another version of) Visual Studio creates extra files or subdirectories, then those names can 
be added as comma separated nodes in the [CVIDE]REMOVE=<subdirectory-or-file-
1>,<subdirectory-or-file-2>… setting. 

 
The benefit of this option: 

- The Project Directory remains small. Only the files that are checked out from SURE have a workspace in 
the project directory. 

 
 
Option [CVIDE]CHECK=<name of read lock file> 
The purpose of this option is to check if the solution is still open in Visual Studio when SURE function Check-in or 
Undo Checkout is used. 
 
Visual Studio creates a read lock file in the workspace when the solution opens for the first time and keeps that 
file locked as long as the solution is open.  

- In Visual Studio 2019, the name of the read lock file is .vs\<LASTNODE>\FileContentIndex\read.lock 
- <LASTNODE> is the last node of the MCP file. 

 
If the option is defined and the solution is still open in Visual Studio when SURE function Check-in or Undo 
Checkout is used, then SURE gives the error message 'Solution is open in Visual Studio'. 
 
If the name of the read lock file is changed in another (newer) version of Visual Studio, then the option must be 
changed in AW_OBJ.INI as well. 
 
The benefits of this option: 

- A developer cannot forget to save his work file in Visual Studio before he does the check-in. 
- If the solution is closed, then none of the files in the workspace is in use. This means that the workspace 

can be removed after check-in or undo checkout (see option [CVIDE]REMOVE=<subdir>). 
 
 
 

Templates for Solution and Project files 
CV-IDE is a plugin for Microsoft Visual Studio for modifying MCP files. Using Visual Studio means that a solution 
file and a project file must be present. With CV-IDE, the solution file has extension SLN, and the project file has 
extension MCPPROJ. 
 
If CV-IDE is defined in SURE as editor for MCP files, then the solution and project file are automatically created by 
SURE when an MCP file is checked out. SURE creates the solution and project file based on predefined templates. 
 
The templates must be loaded into SURE once via one of the following functions: 

- From Cande: RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES") 
- From SURE: Toolbar → Tools → Server environment → Batch functions → LOAD-CVIDE-FILES → Start. 
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Once the templates have been loaded into SURE, they are ready for use at check out. 
 
The full railroad diagram of batch function RESPECT/REPOSITORY("LOAD-CVIDE-FILES"): 
 

 

-- LOAD-CVIDE-FILES---------------------------------------| 

                     |                 |   |         | 

                     |- DEFAULT-BUILD -|   |- RESET -| 

                     |- CUSTOM-BUILD  -| 

 

 
DEFAULT-BUILD 

- The Build Type in the CVIDE project file is always ‘Default’ 
 

CUSTOM-BUILD 
- The Build Type in the CVIDE project file is ‘Custom’ for COBOL, COBOL74, 

COBOL85, ALGOL, DMALGOL and DCALGOL files, and ‘Default’ for all other files. 
- This is the standard method 

 
RESET 

- This option is required if the template files are manually changed in SURE. 
Manually changed templates are only overwritten by this batch function if option 
RESET is used. 

 
 
Read paragraph ‘Local compile started from Visual Studio/CVIDE’ for details about ‘Custom 
Build’ or ‘Default Build’ 
 
 
Examples 
 
RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES") 

- (Re-)load the CVIDE template files. 
o This is only possible if the templates are not manually changed. 

- The Build Type for COBOL and ALGOL files remains unchanged: 
o ‘Default’ if option DEFAULT-BUILD was last used in a previous run of this 

batch function. 
o ‘Custom’ if option CUSTOM-BUILD was last used in a previous run of this 

batch function. 
o ‘Custom’ if options CUSTOM-BUILD and DEFAULT are both never used in 

a previous run, or if option RESET was used in the previous run. 
 
RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES DEFAULT-BUILD") 

- (Re-)load the CVIDE template files. 
o This is only possible if the templates are not manually changed. 

- The Build Type for COBOL and ALGOL files is changed to ‘Default’ 
 
RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES CUSTOM-BUILD") 

- (Re-)load the CVIDE template files. 
o This is only possible if the templates are not manually changed. 

- The Build Type for COBOL and ALGOL files is changed to ‘Custom’ 
 
RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES RESET") 

- (Re-)load the CVIDE template files that were manually changed. 
- The Build Type for COBOL and ALGOL files is changed to ‘Custom’ (because option 

RESET removes an earlier choice for CUSTOM-BUILD or DEFAULT-BUILD, and in 
that case the preferred build method is ‘Custom’)  
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RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES DEFAULT-BUILD RESET") 
- (Re-)load the CVIDE template files that were manually changed. 
- The Build Type for COBOL and ALGOL files is changed to ‘Default’ 

 
 

 
 
 
Customizing the template files 
The template files are generic and are used during check out of any MCP file to create the solution and project 
file for that MCP file. 
 
It is possible to customize the Solution or Project Templates, and to reset them to their default content by 
running RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES RESET"). 
 
To customize the solution template: right click on folder Environment → Maintain CVIDE solution template. 
To customize the project template: right click on folder Environment → Maintain CVIDE project template. 

 
- The content of the template is shown in a continuation screen where it can be changed. 
- The two menu choices are only visible if option ‘Use CV-IDE to edit MCP files’ is enabled. 

 
The templates contain some SURE tokens that are replaced by the actual MCP name, filename, username, et 
cetera, when the solution and project files are created. 
The following SURE tokens are recognized: 

SURE token Replaced by 

<HOSTNAME> The name of the MCP where the file is checked-out 
<PACK> The pack name where the file is checked-out 
<USERCODE> The usercode where is file is checked-out 
<ENVIRONMENT> The SURE environment where the file is checked-out 
<SOURCENAME> The name of the checked-out file 
<LASTNODE> The last node of the file name 
<EXTENSION> The file extension of the local source that is loaded in CV-IDE 
<OBJECTNAME> The name of the compiled object (as defined in SURE) 
<OBJECTPATH> The path of the compiled object (all directories except the last node) 
<SYSTEM The system of the file (as defined in SURE) 
<PROJECT> The project of the file (as defined in SURE) 
<BUILD-TYPE> The build type of the local compile: Default or Custom 
<SUREPACK> The family where the SURE batch programs are located 
<COMPQUEUE> The MCP queue that is used for compilations 
<RSPTITLES> The full name of config file RESPECT/TITLES (incl. usercode and pack) 
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Example 
Suppose that cobol85 file SIM/PS/X100 is checked out in environment DEVELOP to usercode (SIMON) on pack 
PK1 at host CPMCP1. The object name is SIM/PO/X100. 
The SURE tokens are then replaced as follows: 

SURE token Replaced by 

<HOSTNAME> CPMCP1 
<PACK> PK1 
<USERCODE> SIMON 
<ENVIRONMENT> DEVELOP 
<SOURCENAME> SIM/PS/X100 
<LASTNODE> X100 
<EXTENSION> c85_m 
<OBJECTNAME> SIM/PO/X100 
<OBJECTPATH> SIM/PO 

 
 
 
Possible reasons to customize the template files. 
 
The solution template: 

- The current template creates a Visual Studio version 17 compatible file (for Visual Studio 2019). You 
may have to change the template’s version if you use a newer version of Visual Studio with a newer 
solution version. 

 
 
The project template: 

- Tag MCPJobFilePath has value: ??<HOSTNAME>/<PACK>/*WFL/<environment>/COMPILE. 
o This triggers for environment DEVELOP SURE compile job WFL/DEVELOP/COMPILE. 
o You can change the value of tag MCPJobFilePath to the name of your own compilation job. 
o In that case you also must change the values of tags MCPWflParam and 

MCPJobFileErrorFileName. 
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 Task-1695-SURE Improvements for Task Reference 

SURE has the following options for Task Reference 
1. Options to make task reference a required field for a specific environment. 
2. Option to validate the entered task reference.  

 
If the task reference is required for an environment, then it is not possible to transfer a task without a reference 
to that environment.  
The task reference is visible (and changeable via a button) on the task transfer screen. 
 
 

Options to make Task Reference a required field. 
Option 'task reference required' must be enabled for the environment where the reference is required. 

- If the option is enabled, then it is not possible to transfer a task without reference to that environment.  
o Users with specific authorizations can still transfer a task without reference.  

- Once the task has arrived at the environment, the reference cannot be changed or turned off. 
 
Example 
Consider the following configuration and behavior: 

Environment Task reference required 

DEVELOP  
TEST  
ACCEPT yes 
PROD  

 
- A task can be entered into in SURE without a reference. 
- The task can be transferred from DEVELOP to TEST without a reference. 
- If the task is transferred to ACCEPT then the reference is required. 
- If the task was transferred from environment TEST to ACCEPT and has status ACCEPT, then the 

reference cannot be changed. 
- If the task has status SOLVED or QUICKFIX, then the reference cannot be changed. 
- If the task is reactivated to DEVELOP then the reference can be changed.  

 
How to enable the option 
Option Task Reference Required can be enabled at the following levels: 

1. Environment 
o Right click on <environment> ➔ Properties ➔ tab Environment 
o The task reference is required when any task is transferred to that environment. 

 
2. System on environment 

o Folder Configuration ➔ System ➔ <environment> ➔ <system> ➔ Right click on <system-
project> ➔ Properties. 

o The task reference is required when a task of that system is transferred to that environment. 
 

3. Project on environment 
o Folder Configuration ➔ System ➔ <environment> ➔ <system> ➔ Right click on <project> ➔ 

Properties. 
o The task reference is required when a task of that project is transferred to that environment. 

 
4. File-type on environment 

o Folder Configuration ➔ Task-type ➔ Right click on <task-type> ➔ Properties ➔ tab 
Miscellaneous. 

o The task reference is required when a task with that file-type is transferred to that 
environment. 

 
 

Option to validate the task reference that is entered on the screen. 
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The entered task reference can be validated via procedure SITE_TASKREF in the SURE site library. 
 
The task validation is only enabled if the SURE site library is active and procedure SITE_TASKREF is exported in 
the site library. 
 
The validation of the reference is done at the following moments: 

- When a task is transferred to the environment where the reference is required. 
o So (with the earlier used example configuration):  

▪ The reference can be added or changed without validation when the task has status 
DEVELOP or TEST. 

▪ The validation is done when the task is transferred to ACCEPT, and then the reference 
cannot be changed anymore  

- When a task is added for an environment where the reference is required. 
 
The following is an example of the procedure SITE_TASKREF where each reference number must start with ‘ABC’ 
 

STRING PROCEDURE SITE_TASKREF 

           (S_SYS,S_PRJ,S_TPE,S_REF); 

    VALUE   S_SYS,S_PRJ,S_TPE,S_REF; 

    STRING  S_SYS,S_PRJ,S_TPE,S_REF; 

BEGIN 

 % Use this function to validate the task-reference 

 % Input: 

 %    S_SYS = the task-system  (if the reference depends on a system) 

 %    S_PRJ = the task-project (if the reference depends on a project) 

 %    S_TPE = the task-type    (if the reference depends on the type) 

 %    S_REF = the task-reference 

 % Response: 

 %    The procedure result = an error message if the reference is wrong 

 % Example: 

 %    DISPLAY("SITE_TASKREF:"!!S_SYS!!","!!S_PRJ!!","!! 

 %                             S_TPE!!","!!S_REF); 

 %    IF TAKE(S_REF!!"   ",3) NEQ "ABC" THEN 

 %       SITE_TASKREF := "Invalid task reference"; 

END; 

 

 

EXPORT SITE_TASKREF; 

      

 
Via the SURE site library it is also possible to make a call on another application system to verify the reference 
number. 
 
  



SURE Release 110 

Releasenotes110.docx 42  

 Task-1701-SURE Use UltraEdit as local editor for MCP sources 

UltraEdit is a powerful text editor and source code editor for use with Microsoft Windows. See the UltraEdit 
home webpage (www.ultraedit.com) for details. 
 
UltraEdit can also be used in combination with SURE as the local editor for MCP sources. 
 
The following configuration gives a smooth integration of UltraEdit with SURE and good support for MCP sources. 
 

Configuration in SURE  
 
Define UltraEdit as the Local Editor for MCP sources as follows: 

Toolbar → Options → SURE options → tab: Local Options: 
Field Value 
Edit MCP files Enter the full name of the UltraEdit program 

(<path>\uedit64.exe) 
 
Define the number for OLE-server (to be able to start a compilation from UltraEdit): 

Toolbar → Options → SURE options → tab: Local Options: 
Field Value 
OLE server id Enter a number between 1 and 99. 

- If SURE is installed multiple times on a 
workstation, then each instance must have 
a unique OLE server id. 

 
 
 

Configuration in UltraEdit 
 
For most options, the default value (which comes with the installation) is fine, but a few options need attention 
to make things better. 
 
Configure keyboard button [Tab] as 1 space: 

- Toolbar → Advanced → Configuration → Navigate: Editor →Word wrap/tab settings: 
Field Value 
Use spaces in place of tabs Enabled 
Tab stop value 1 
Indent spaces 1 

 
Reason: an MCP source file should not contain tabs. 
 

 
 
Enable syntax highlighting for languages COBOL: 

- Toolbar → Advanced → Configuration → Navigate: Editor displays → Syntax Highlighting: 
- Click on button [Add/remove languages] to add COBOL and to remove unneeded languages. 
- On the continuation screen: 

o Enable language COBOL. 
o Double click on the line with COBOL to open file cobol.uew with COBOL definitions. 

▪ On the first line (at the end): add file extensions C74 and C85. 
▪ Save file cobol.uew. 

 
 
 
Optional: enable auto-complete for COBOL: 

- Toolbar → Advanced → Configuration → Navigate: Auto complete → Intellitips → Miscellaneous: 
Field Value 

http://www.ultraedit.com/
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Auto-complete text Enabled 
When … chars are typed 8 

 
- Toolbar → Advanced → Configuration → Navigate: Auto complete → Intellitips → File types: 

Field Value 
Double click on the line with COBOL Add extensions: .c74.c85.cpy 

 
Reason: this can be handy, but it becomes annoying if the number of characters is low. 

 
 
 
Enable the option to save the current file automatically when the desktop focus changes to another window: 

- Toolbar → Advanced → Configuration → Navigate: Editor → Advanced: 
Field Value 
Auto-save modified documents when 
application loses focus 

Enabled 

 
Reason: if this option is enabled then the changes in UltraEdit are automatically saved when you switch 
to another app. For example when you switch to SURE to do the check in. This improves the integration 
between SURE and UltraEdit 

 
 
 
Enable the option to allow cursor positioning beyond the end of a line: 

- Toolbar → Advanced → Configuration → Navigate: Editor display → Cursor / caret: 
Field Value 
Allow positioning beyond line end Enabled 

 
Reason: just handy.  

 
 
 
Add extra buttons on the toolbar: 

- Click on the last icon of the toolbar (you will see ‘Toolbar options’) → Add or remove buttons → 
Customize: 

 
o Select category ‘Search’ 
o Drag and drop command ‘Previous changed line’ to the toolbar. 
o Drag and drop command ‘Next changed line’ to the toolbar. 

 
- Another method is to change the toolbar to a ribbon. 

 
Reason: this makes it easy to jump to locations in the source that are changed. 

 
 
 
Enable the option to keep changed lines over an intermediate file save: 

- Toolbar → Advanced → Configuration → Navigate: Editor display → Line change indicator: 
Field Value 
Enable line change indicator Enabled 
Treat saved LCI’s as changed lines Enabled 
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Reason: This allows the developer to jump forwards and backwards in his source code to the places 
where he changed something, since the moment that the source was opened in UltraEdit. 

 
 
 
Optional: disable the option to backup a file when it is saved: 

- Toolbar → Advanced → Configuration → Navigate: File handling → backup: 
Field Value 
No backup Enabled 

 
Reason: there is no reason to make intermediate backups.  

 
 
 
Define the RUN command to start a Local Compile for the current source: 

- Toolbar → Advanced → Tool configuration 

- Press button [Insert] to define the command as follows: 
o Tab ‘Command’ 

Field Value 
Menu item name Compile 
Command line C:\SURE\RIS\BIN\AS_Comp.exe %f /O 

<OLE-number> 

- The full name of AS_Comp.exe 

- OLE-number is defined in SURE 
local options 

 
o Tab ‘Options’ 

Field Value 
Program type DOS program 
Save active file Enabled 
Save all files first Enabled 

- Because changed include files 
must be saved as well 

 
Non-mentioned fields are not relevant. 

 
To start the compilation: select the command from the menu under Toolbar → Advanced. 

 
 
 
Define the RUN command to load the file with syntax errors for the current source: 

- Toolbar → Advanced → Tool configuration 

- Press button [Insert] to define the command as follows: 
o Tab ‘Command’ 

Field Value 
Menu item name Show syntax errors 
Command line C:\SURE\RIS\BIN\AS_run.exe /E /C /R:0:1 %f 

- The full name of AS_run.exe 
 

o Tab ‘Options’ 
Field Value 
Program type DOS program 
Save active file Disabled 
Save all files first Disabled 

 
o Tab ‘Output’ 

Field Value 
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Capture output Enabled 
Clear output before run Enabled 
Output to list box Enabled 
Replace selected text No replace 
Handle output as  ANSI 

 
Non-mentioned fields are not relevant. 

 
To load the syntax errors: select the command from the menu under Toolbar → Advanced. 

 
Double click on a line with a syntax error in the output window to position the source file on that error. 
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 Task-1709-SURE Implement SURE Site Library for the SURE Windows backend 

It has been possible for a long time to define a Site Library for the SURE MCP backend. This is now also possible 
for the SURE Windows backend. 
 
Currently the only supported function is SITE_EVENT. This feature can be used to intercept the SURE log events 
and then perform site specific actions on these events. 
 
The sources of an example site library are delivered together with SURE Windows backend, in directory 
Release\SiteLibrary. It is a C++ project: 

Release 
        BIN 
        DATA 
        INSTALL 
        SCRIPT 
        SiteLibrary 
               SiteLibrary.cpp 
               SiteLibrary.sln 
               SiteLibrary.vcxproj 
               SiteLibrary.vcxproj.filters 
        Web 
        Install.bat 
 
You can customize the source to your own needs, as long as the declaration of procedure SITE_EVENT remains 
unchanged. 

- The original version of the site library (the one that is delivered) creates example file C:\Temp\Temp.txt 
and writes a record in that file each time when procedure SITE_EVENT is called. The content of that file 
may help you with your customization. 

 
 
Activation of the site library 
 

1. Copy directory Release\SiteLibrary to another location, so that your changes will not be overwritten 
when you install the SURE Windows backend software again. 
 

2. Open SiteLibrary.sln in Visual Studio, make your changes, and build the project. 
 

3. Copy the result (SiteLibrary.dll) to directory SURESERVER\BIN\, the same location where all other 
executables and dll’s of the SURE Windows backend are placed. 
 

4. Start the SURE Windows backend. 
 

5. Open the SURE client and define the name of the site library. 
a. Right click on folder Environment → Global Options 
b. Open tab ‘SURE’ 
c. Enter in field SURE Site Library:  ‘SiteLibrary.dll’ 
d. Press [Apply] 

 
6. Stop and restart the SURE Windows backend. 
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 Task-1710-SURE Use Notepad++ as local editor for MCP sources 

Notepad++ is a popular (distributed as free software) text editor and source code editor for use with Microsoft 
Windows. It supports tabbed editing, which allows working with multiple open files in a single window. See the 
Notepad++ home webpage ( www.notepad-plus-plus.org ) for details. 
 
Notepad++ can also be used in combination with SURE as the local editor for MCP sources. 
 
The following configuration gives a smooth integration of Notepad++ with SURE and good support for MCP 
sources and/or MicroFocus-COBOL sources 
 

Configuration in SURE  
 
Define Notepad++ as the Local Editor for MCP sources as follows: 

Toolbar → Options → SURE options → tab: Local Options: 
Field Value 
Edit MCP files Enter the full name of the Notepad++ program 

(<path>\Notepad++.exe) 
 
Define the number for OLE-server (to be able to start a compilation from Notepad++): 

Toolbar → Options → SURE options → tab: Local Options: 
Field Value 
OLE server id Enter a number between 1 and 99. 

- If SURE is installed multiple times on a 
workstation, then each instance must have 
a unique OLE server id. 

 
 

Configuration in Notepad++ 
 
For most options, the default value (which comes with the installation of Notepad++) is fine, but a few options 
need attention to make things better. 
These options are stipulated in the following paragraphs. 
 
 

Install the SURE MCP Source Editor plugin 
 
ITSforSURE has created a plugin to improve the support for MCP source files with filekinds COBOL, ALGOL, and 
JOB. The plugin can be found in the SUREforWindows BIN directory 

The SUREforWindows BIN directory = <SURE installation directory>\RIS\BIN\ 
 
The MCPSourceEditor plugin has the following functionality:  

- The plugin works for sources with file extension C74, C85, COB, CBL, DMA, DCA, ALG, or JOB. 
- Jump quickly forwards or backwards to the changes that you made in the source. 
- Automatically create the new sequence number (length 6 for COBOL, length 8 for ALGOL and WFL) for 

new lines in the source. 
o When a new line is created via the enter button 
o When lines are copied or moved to another place in the source (copy/paste special) 

- Resequence a part of the work file. 
- A warning (color) when text is typed after position 72 (COBOL), 80 (ALGOL), or 88 (WFL). 
- Start a compilation on the MCP of a source that is opened in Notepad++. 
- If the file has syntax errors: show the error file and position the source automatically on the line with 

the syntax error. 
- Short keys and toolbar icons are available for all these functions. 

 
 

http://www.notepad-plus-plus.org/
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Example 

 
- The icons for functions re-sequence, compile, jump to changed lines, and show syntax errors are placed 

on the toolbar. 

 Open the error file and show the syntax errors. 
 

 Compile the source on the MCP. If syntax errors are found, then the error file is 
automatically opened. 
 

 Jump backwards in the source to the previous changed line (since the source was 
opened in Notepad++). 
 

 Jump forwards in the source to the next changed line (since the source was opened in 
Notepad++). 
 

 Resequence the selected lines. 

 
- The available short keys are listed under Menu bar → Plugins → MCP source Editor  

CTRL-ALT-C Compile the source on the MCP. If syntax errors are found, then the 
error file is automatically opened. 
 

CTRL-ALT-E Open the error file and show the syntax errors. 
 

CTRL-ALT-N Jump forwards in the source to the next changed line (since the source 
was opened in Notepad++). 
 

CTRL-ALT-P Jump backwards in the source to the previous changed line (since the 
source was opened in Notepad++). 
 

CTRL-ALT-Q Resequence the selected lines. 
 

CTRL-ALT-V Paste with new sequence numbers. 
 

CTRL-ALT-1,2,3,4 Only applicable if compilers are defined for multiple repositories. 
Activate the compiler with that number and start it. 
 

CTRL-ALT-7 Switch ‘Paste Special’ to ‘with new line numbers’ mode. 
 

CTRL-ALT-8 Switch ‘Paste Special’ to ‘with empty line numbers’ mode. 
 

CTRL-ALT-9 Switch ‘Paste Special’ to ‘with unchanged line numbers’ mode. 
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Example of compilation and loading syntax errors 
 
Start a compilation by pressing the compile icon, or via short key CTRL-ALT-C: 

 
 
The compilation is done on the MCP under the control of program AS_COMP.EXE: 

 
- In this example the compiler found syntax errors 
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The error file is automatically opened in an extra pane of Notepad++: 

 
 
Double click on a line in the error file to position on that line in the source: 
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Installation 
Copy <SURE installation directory>\RIS\BIN\MCPSourceEditor.dll 
     as <Notepad++ installation directory>\plugins\MCPSourceEditor\MCPSourceEditor.dll 
 
 
Configuration 
Menu bar → Plugins → MCP Source Editor → Options 

 
- Radio button ‘Numbering of new lines’ 

• Insert new line number The new line automatically gets a new sequence number 
(length 6 for COBOL, length 8 for ALGOL and WFL). This is the 
preferred setting for MCP sources. 

• Insert empty line number The new line gets an empty sequence number (6 or 8 
spaces). This is the preferred setting for MicroFocus-COBOL 
sources. 

• No action No action; the cursor starts at position 1  

 
- Paste special of multi line block 

• With new line number The new lines automatically get new sequence numbers 
(length 6 for COBOL, length 8 for ALGOL and WFL). This is the 
preferred setting for MCP sources. 

• With empty line number The new lines get an empty sequence number (6 or 8 
spaces). This is the preferred setting for MicroFocus-COBOL 
sources. 

• With unchanged number The original sequence numbers are kept 

 
- Show warning color for characters beyond right margin 

o The background color changes to bright orange if characters are typed or pasted beyond the 
right margin at position 72 (COBOL), 80 (ALGOL), or 88 (WFL). 

 
- Short keys for functions of this plug-in 

o You can change the short keys to your own preferences, for example when a short key is 
already in use by another plugin that you installed 

 



SURE Release 110 

Releasenotes110.docx 52  

- Increment scheme for (re)numbering actions 
o This is applicable for the functions where new sequence numbers are created (paste special, re-

sequence, and enter new line).  
o For example: scheme ‘1000, 100, 10, 1’ means: new sequence numbers are increased with 

1000 until it does not fit anymore, then 100 until it does not fit anymore, then 10, and finally 
the number is increased by 1. 

 
- Options for Compile 

o These settings are only relevant when MCP sources are compiled (so, not for MF-COBOL). 
o It is possible to define compile support for up to 4 different SURE repositories. For each SURE 

repository, the following must be defined: 
Field Value 
Name The logical name of the SURE repository 

 
Executable <SURE installation directory>\RIS\BIN\AS_COMP.EXE 

 
SURE OLE The OLE server id of the SURE client that works for the SURE repository. If 

the SURE client is installed multiple times on a workstation, then each 
instance must have a unique OLE server id. 
 

Radio button 
1,2,3,4 

This is only applicable if compile support is defined for multiple SURE 
repositories: 

- Each defined compiler has its own number from 1 to 4. This radio 
button identifies the compiler for the SURE repository that is 
currently active on your Notepad++ session. 

- Short key CTRL-ALT-C and the Compile Icon on the toolbar start 
the compilation for that repository. 

 
 
 

Import syntax highlighting for languages COBOL, ALGOL, and JOB 
 
ITSforSURE has created 3 configuration files for syntax highlighting that you can import in Notepad++. The 
configuration files can be found in the SUREforWindows HELP directory. 

The SUREforWindows HELP directory = <SURE installation directory>\RIS\HELP\ 
 
Installation: 

- Menu bar → Language → User Defined Language → Define your language → Button [Import]: 
Import file “NotepadPlus syntax highlighting for language Unisys-ALGOL.XML” from the SURE 
help directory SURE\RIS\HELP\ 

 
Import file “NotepadPlus syntax highlighting for language Unisys-COBOL.XML” from the SURE 
help directory SURE\RIS\HELP\ 
 
Import file “NotepadPlus syntax highlighting for language Unisys-JOB.XML” from the SURE help 
directory SURE\RIS\HELP\ 

 
Restart Notepad++ to activate the new languages 

 
 
About the syntax highlighting: 

- The most frequently used commands are highlighted. You can adjust the set with recognized keywords 
to your own needs, as follows: 

o Open screen Menu bar → Language → Define your language 
o Select the language via the User language button (top left corner) 
o Go to tab <Keywords lists> to adjust the lists with recognized words 
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- For COBOL, ALGOL, and JOB: the language syntax statements, and the Unisys file and task attributes are 
highlighted in bold and with background color ‘light yellow’: 

 
 

- For COBOL and ALGOL: DMS2 statements are highlighted in bold and with background color orange: 

 
 

- For ALGOL and JOB: The keywords BEGIN and END are highlighted in bold and with background color 
‘light blue’: 

 
 

 

- Number and string literals are highlighted in foreground color ‘bright blue’ 

- Comment lines are highlighted in italic and foreground color red 

- Dollar cards are highlighted in foreground color green 
 
You are free to adjust the colors used to your own preference 
 
 

Other options of Notepad++ 
 
Configure keyboard button [Tab] as 1 space 

- Menu bar → Settings → Preferences → tab: Language → 
Field Value 
Tab size  1 
Replace by space  Enabled 

 
Reason: an MCP source file should not contain tabs. 

 
 
 
Allow to select text between delimiters over multiple lines 

- Menu bar → Settings → Preferences → tab: Delimiter → 
Field Value 
Open and Close enter appropriate open and close delimiters 
Allow on several lines  Enabled 

 
Reason: this option helps the developer to find a matching delimiter 

 
 
 
Enable the option to allow cursor positioning beyond the end of a line: 

- Menu bar → Settings → Preferences → tab: Editing → 
Field Value 
Enable virtual space  Enabled 
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Reason: handy for developers 

o If the option is disabled, then you cannot place your cursor in the trailing spaces after the end 
of a line 

o If the option is enabled, then you can place your cursor anywhere on the line 
 
 
 
Disable the option to backup a file when it is saved: 

- Menu bar → Settings → Preferences → Backup → 
Field Value 
Backup on save  None 

 
Reason: there is no reason to make intermediate backups when working with SURE 

 
 
 
Import the plugin to save the current file automatically when the desktop focus changes to another Window 

- Menu bar → Plugins → Plugin Admin... → Tab: Available 
  Select plugin ‘AutoSave’ → [Install] 
 

Configure plugin AutoSave as follows: 
o Menu bar → Plugins → AutoSave → Options 

 
 

Reason: when plugin AutoSave is installed then the changes in Notepad++ are automatically saved when 
you switch to another app. For example when you switch to SURE to do the check in. This improves the 
integration between SURE and Notepad++. 

 
 
 
Try the function in Notepad++ to shift a group of lines to left or right: 

- Select a column in the source with [Alt] + Drag mouse with left button pressed 
 
To shift lines to right: press [Tab] 
To shift lines to left: press [Delete] 
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Update the Popup Context Menu 
 
A right mouse click anywhere in the source shows the Popup Context Menu.  
It is possible to customize this menu.  
 
Reason: 

- For developers it is very handy when commands ‘Resequence range’ and ‘Paste Special’ (both 
commands are from the MCP Source Editor plugin) are added to the Popup Context Menu, because 
those two commands are typically used when you are working with the mouse. 
Example: 

o In case of function Resequence Range: 
▪ First select multiple lines via the mouse. 
▪ Then right click with the mouse and use function Resequence Range. 

o In case of function Paste with New Line Numbers: 
▪ First select multiple lines via the mouse. 
▪ Then right click with the mouse to use function Copy. 
▪ Finally position the mouse at the destination location in the source, right click, and use 

function Paste Special. 
 
Update the Popup Context Menu as follows:  

- Menu bar → Settings → Edit Popup Context Menu 

- This opens file Contextmenu.xml  

- Update Contextmenu.xml and add the two yellow marked lines to section <ScintillaContextMenu>: 
<Item MenuEntryName="Edit" MenuItemName="Cut"/> 

<Item MenuEntryName="Edit" MenuItemName="Copy"/> 

<Item MenuEntryName="Edit" MenuItemName="Paste"/> 

<Item PluginEntryName="MCP Source Editor" PluginCommandItemName="Paste Special"/> 

<Item PluginEntryName="MCP Source Editor" PluginCommandItemName="Resequence range" /> 

<Item MenuEntryName="Edit" MenuItemName="Delete"/> 

<Item MenuEntryName="Edit" MenuItemName="Select all"/> 

 

- Save file Contextmenu.xml and restart Notepad++ to test the changed context menu. 
 
You can customize the menu to your own preferences and remove commands from the menu that you will not 
need. 
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 Task-1741-SURE Overview of new, changed, and deleted files 

SURE now keeps a separate log of files that are new, changed, or deleted in an environment. 
 
Print function CHANGED-FILES creates an overview of this log. 
 
 

Parameters Explanation 

 
ENABLE 
 

 
This option enabled the logging of new, changed, or deleted files. 

DISABLE 
 

This option disables the logging of new, changed, or deleted files. 

PROJECT 
 

This parameter is used as a filter. If used, then only the files of this project 
are selected.  
 

CLEAR 
 

This parameter cleans the log when it is printed. This option is handy when 
you run the batch function on a daily basis. In that case the overview gives 
the files that were added, changed, or deleted since the previous run. 
 

ALSO-CSV 
 

If this parameter is used, then a CSV file is created too. The name of the CSV 
file is RESPECT/DUMP/CHANGED-FILES. 
 

CSV-SEP 
 

This parameter can be used to change the separator in the CSV-file. By 
default, the separator is a comma. 

 
Example 
RUN RESPECT/PRINT("CHANGED-FILES ENABLE");  

RUN RESPECT/PRINT("CHANGED-FILES CLEAR ALSO-CSV CSV-SEP |");  
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 Task-1768-SURE New option to deploy compiled objects via FTP instead of BNA 

RESPECT/SURE/TRANSFER generates a transfer-job that copies compiled objects from the SURE compile location 
to the run location. By default, the objects are copied via BNA.  
 
It is now possible to enable a new option so that the objects are copied via FTP. The option must be defined for 
the environments where it is needed. 
 
To enable the new option permanently:  

- Run program RESPECT/SURE/TRANSFER once with parameter "ENABLE VIA-FTP" 
o RUN RESPECT/SURE/TRANSFER(" ENABLE VIA-FTP "); TASKSTRING="PRODUCTION"; 

- After this, subsequent runs of RESPECT/SURE/TRANSFER for environment PRODUCTION will use the new 
method: copy-via-FTP 

 
To disable the option:  

- Run program RESPECT/SURE/TRANSFER once with parameter "DISABLE VIA-FTP" 
o RUN RESPECT/SURE/TRANSFER(" DISABLE VIA-FTP "); TASKSTRING="PRODUCTION"; 

- After this, subsequent runs of RESPECT/SURE/TRANSFER for environment PRODUCTION will use the 
default method: copy-via-BNA 

 
To use the new method once, while the new option is not enabled (for example for testing purposes) 

- RUN RESPECT/SURE/TRANSFER(" VIA-FTP "); 
 
 
FTP requires a usercode/password 
 
An FTP file transfer COPY statement requires a usercode + password to be able to connect to the destination 
host: 

COPY (SURE_PRO_BATCH)OBJECT/SYS1/P25                          

  AS (TEST)OBJECT/SYS1/P25                                    

        (FTPTYPE = MCPDATA,FTPSITE = "OPTION - RESTRICTED")   

FROM DBREP(PACK)                                              

  TO DBREP(PACK,HOSTNAME=IDTEST                               

          ,USERCODE=#USCD/#PW) [T];                           

 
- By default, the user code in variable USCD is the same as the SURE batch usercode where 

RESPECT/SURE/TRANSFER runs, but you can override it with another usercode via 
SURE/WFLINCLUDE/TRANSFER at lines 30000000 to 30999999. 

 
- For security reasons, the password of this user code cannot be generated automatically in the job, and 

therefore it must be set in variable PW via include file SURE/WFLINCLUDE/TRANSFER at lines 30000000 
to 30999999. 

 
 
About SURE/WFLINCLUDE/TRANSFER 
 
Include file SURE/WFLINCLUDE/TRANSFER can be used to customize the transfer-job that is generated by 
RESPECT/SURE/TRANSFER.  
 
If file SURE/WFLINCLUDE/TRANSFER is visible (under the SURE-usercode or under the * directory) for 
RESPECT/SURE/TRANSFER, then it is included in the generated transfer job, as follows:  

- In the generated job, at the beginning of the file 
$ INCLUDE SURE/WFLINCLUDE/TRANSFER 10000000 TO 19999999 

▪ Use this sequence range for declarations of variables 
- In the generated job, after the declarations 

ENVIRONMENTNAME := "PRODUCTION";      

DESTINATIONPACK := "DISK_IDTEST";  

BATCHUSERCODE   := "SURE_PRO_BATCH";        

USCD            := BATCHUSERCODE; 
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$ INCLUDE SURE/WFLINCLUDE/TRANSFER 30000000 TO 30999999 

▪ Use this sequence range to give an initial value to variables. 
▪ The string variables ENVIRONMENTNAME, DESTINATIONPACK and BATCHUSERCODE 

are environment variables, and can be used in SURE/WFLINCLUDE/TRANSFER to 
determine the exact situation. 

- In the generated job, at the end 
$ INCLUDE SURE/WFLINCLUDE/TRANSFER 20000000 TO 29999999 

▪ Use this sequence range to do site-specific things at the end of the job, when the 
compiled objects are all copied 

 
If file SURE/WFLINCLUDE/TRANSFER is not visible then no INCLUDE statements are generated into the transfer-
job. 
 
Example of SURE/WFLINCLUDE/TRANSFER 

NEXT+   ....*....1....*....2....*....3....*....4....*....5....*....6....*....7   

10000000 %seq-range 10000000-19999999 for declarations                           

10000100                                                                         

19999999                                                                         

20000000 %seq-range 20000000-29999999 is included at the end of the transfer job 

20000100                                                                         

29999999                                                                         

30000000 %seq-range 30000000-30999999 is included at the start of the job        

30000100 IF BATCHUSERCODE = "SURE_PRO-BATCH" THEN                                

30000200    PW := "PASS";                                                        

30999999                                                                         

#DISPLAY COMPLETE                                                                

 
Example how sequence range 30000000-30999999 of file SURE/WFLINCLUDE/TRANSFER is included in the 
generated transfer-job: 

 STRING USCD                                                  

       ,PW                                                    

       ,ENVIRONMENTNAME                                       

       ,DESTINATIONPACK                                       

       ,BATCHUSERCODE                                         

       ;                                                      

 ENVIRONMENTNAME := "DEVELOP";                                

 DESTINATIONPACK := "DBREP_IDTEST";                           

 BATCHUSERCODE   := "SURE_PRO_BATCH";                         

 USCD            := BATCHUSERCODE;                            

                                                              

$ INCLUDE SURE/WFLINCLUDE/TRANSFER 30000000 TO 30999999       

                                                              

COPY (SURE_PRO_BATCH)OBJECT/SYS1/P25                          

  AS (TEST)OBJECT/SYS1/P25                                    

        (FTPTYPE = MCPDATA,FTPSITE = "OPTION - RESTRICTED")   

FROM DBREP(PACK)                                              

  TO DBREP(PACK,HOSTNAME=IDTEST                               

          ,USERCODE=#USCD/#PW) [T];                           
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 Task-1778-SURE Implement domain check for list and view functions 

 
The domain check was already available for the following update functions: 

- File: Update, Request, Check-Out, Resequence, Rename, Purge, Recover, Change-Filekind, Remove, 
Restore, Change Attachment 

- Datadict: add/update/delete data-item, format or process 
 
The domain check is now also available for inquiry functions:  

- List, Copy, View ,open with, list and view of delta-files 
 
A domain for update functions is defined as follows: 

- Create a new employee-function without an authorization scheme 
- Enable the following option on the properties screen on the new employee-function: 

o Employee-function is used as domain 
 
A domain for inquiry functions is defined as follows: 

- Create a new employee-function without an authorization scheme 
- Enable the following option on the properties screen on the new employee-function: 

o Employee-function is used as domain 
- Create (via Configuration => Drop down box value => New ) a new value list with Type = DOMAIN-INQ 

o This must be done once 
- Add the new domain to the DOMAIN-INQ value list 

 
 
The domain check for inquiry functions works independently from the existing domain check for update 
functions. 
 
For example: if a file has an inquire domain but no update domain, then the domain check is only done for the 
inquire functions, and not for the update functions because the file has no update domain. 
 
The following table describes all possibilities: 
 

- Domain CSI-INQ is a domain for inquiry functions 
- Domain CSI-UPD is a domain for update functions 

 

 User with domain 
CSI-INQ only CSI-UPD only  CSI-INQ and  

CSI-UPD 
None  

Fi
le

 w
it

h
 d

o
m

ai
n

 

CSI-INQ Inquiries: domain 
OK 
Updates: no 
domain check 

Inquiries: 
domain not OK 
Updates: no 
domain check 

Inquiries: 
domain OK 
Updates: no 
domain check 

Inquiries: domain 
not OK 
Updates: no 
domain check 

CSI-UPD Inquiries: no 
domain check 
Updates: domain 
not OK 

Inquiries: no 
domain check 
Updates: 
domain OK 

Inquiries: no 
domain check 
Updates: 
domain OK 

Inquiries: no 
domain check 
Updates: domain 
not OK 

CSI-INQ 
and  
CSI-UPD 

Inquiries: domain 
OK 
Updates: domain 
not OK 

Inquiries: 
domain not OK 
Updates: 
domain OK 

Inquiries: 
domain OK 
Updates: 
domain OK 

Inquiries: domain 
not OK 
Updates: domain 
not OK 

none Inquiries: no 
domain check 
Updates: no 
domain check 

Inquiries: no 
domain check 
Updates: no 
domain check 

Inquiries: no 
domain check 
Updates: no 
domain check 

Inquiries: no 
domain check 
Updates: no 
domain check 
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- ‘No domain check’ means: no domain check is done, so the user can do the functions if he has the 
correct authorizations. 

 
- ‘Domain OK’ means: the user has the correct domain, and he can do the functions if he has the correct 

authorizations. 
 

- ‘Domain not OK’ means: the user does not have the correct domain, so he cannot do the function, even 
when he has the correct authorizations. 

 
This implementation is compatible with existing (old) domain definitions in SURE 
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 Task-1793-SURE New option to WAIT-ON-FILE-RESIDENT at incorrect deploy 

RESPECT/SURE/TRANSFER offers a new method to wait on an incomplete deployment. 
 
The compile-and-deploy procedure works as follows: 

- RESPECT/SURE/COMPILE compiles the programs that are in the SURE compile-queue. 
- RESPECT/SURE/TRANSFER creates and starts ‘Transfer Jobs’ and a ‘Remove Job’ 

o Transfer jobs copy the compiled objects to the final locations. 
o The remove job removes the compiled objects from the SURE-compilation location, to keep 

that location clean. 
 
The remove job waits until all compiled objects are correctly copied to the final locations before it cleans up the 
SURE compilation location. That works as follows: 

- The remove job waits on ‘Transfer-Ready-Files’ that are created by the transfer jobs.  
o The name of the Transfer-Ready-File is SURE/TRANSFER/FILE-CONTROL/<pack-

name>/READY/<yyyymmddhhmiss> 
o The last action of each transfer job creates the Transfer-Ready-File, so when all objects are 

correctly copied to the final location 
 
If for some reason a transfer job is DS-ed, then its Transfer-Ready-File is not created, and then the remove job 
starts waiting. If the Transfer-Ready-File is not created, then some objects are perhaps not copied, and that may 
cause issues in production.  
 
The method of waiting is improved 
 
Previously, program RESPECT/TOOLS managed the wait phase of the remove job. This program waits and gives 
every minute a display until Transfer-Ready-File is resident. RESPECT/TOOLS keeps displaying the message until a 
person has investigated why the Transfer-Job did not create the Transfer-Ready-File and has fixed the case. A 
solution can be to put some programs again in the SURE compile queue, and to repeat the compile and deploy. 
 
The disadvantage of this method is that operating staff do not always notice the displays, and that blocks the 
deployment. 
 
We created an extra method that enforces a waiting entry in the mix. Waiting entries are better noticed by 
operating staff,  
 
To enable the new option permanently:  

- Run program RESPECT/SURE/TRANSFER once with parameter "ENABLE WAIT-FILERESIDENT" 
o RUN RESPECT/SURE/TRANSFER(" ENABLE WAIT-FILERESIDENT ");  

- After this, subsequent runs of RESPECT/SURE/TRANSFER will use the new method via WFL statement 
WAIT(FILE <transfer-ready-file> IS RESIDENT); 

 
To disable the option:  

- Run program RESPECT/SURE/TRANSFER once with parameter "DISABLE WAIT-FILERESIDENT " 
o RUN RESPECT/SURE/TRANSFER(" DISABLE WAIT-FILERESIDENT ");  

- After this, subsequent runs of RESPECT/SURE/TRANSFER will use the old method: RUN 
RESPECT/TOOLS("WAIT-RESIDENT <transfer-ready-file>") 

 
To use the new method once, while the new option is not enabled (for example for testing purposes) 

- RUN RESPECT/SURE/TRANSFER(" WAIT-FILERESIDENT "); 
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 3 New or deleted batch programs and batch functions 
This paragraph gives a summary of the changed batch functions. 
 
All these batch function can be started via Toolbar → Tools → Server environment -> Batch functions. 
 

  ABOUT-SURE (Batch Function) 

This batch function creates an overview with the following information: 
- For each installed RIS/SURE program: the release-id, creation date, and last access date 
- For each repository conversion: the date when the conversion was done  

 

Example 
RUN RESPECT/REPOSITORY("ABOUT-SURE"); 

 
The listing can be downloaded via the SURE client, as follows: 
 Open folder SURE server → Batch reports → BATCHOUTPUT/<date> 
 Right click on file <timestamp>_PRINT/ABOUT-SURE 
 Select ‘Download’ from the menu 
 
 
 

  ALWAYS-LISTING (Batch Function) 

Batch program RESPECT/SURE/ALWAYS/LISTING is changed to batch function ALWAYS-LISTING in program 
RESPECT/REPOSITORY. 
 
This batch functions enables or disables option ‘Create always compile listings when a $SET LIST is in the 
compiled source’  
 
 

ALWAYS-LISTING ----- ENABLE ----------| 

                 |-- DISABLE -|     

 

 
This option can also be defined via the SURE GUI, as follows: 

- Right click on the name of the environment where you want to change the option → Properties → Tab 
SURE batch 

 
 

Parameters Explanation 

 
ENABLE 

 
Enable option ‘Create always compile listings’ 
 

DISABLE Disable option ‘Create always compile listings’ 
 

Example 
RUN RESPECT/REPOSITORY("ALWAYS-LISTING ENABLE"); 

 
 
 

  CLEAN-REVIEWED (Batch Function) 

This batch function of RESPECT/REPOSITORY cleans old code review information.  
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                |----<---------------------------|   

CLEAN-REVIEWED ---- UNTIL --- <yyyymmdd> ----------| 

                 |         |-- TODAY - <days> -|     

                 |                             |     

                 |- FILE <file> ---------------|     

 

 
Parameters Explanation 

 
UNTIL <option> 

 
This parameter is required. 
UNTIL <yyyymmdd> : 

- Select all files with code review info older than <yyyymmdd> 
 
UNTIL TODAY - <nr> : 

- select all files with code review info older than <nr> days ago. 
- This method can be used in a job that runs every week 

 
FILE <file name> This parameter is optional and works as a filter: if used then only this file is 

selected. This is for debugging purposes. 
 

 
Example 
RUN RESPECT/REPOSITORY("CLEAN-REVIEWED UNTIL TODAY - 7"); 

 
 
 

  REVIEWED-OVERVIEW (Batch Function) 

This batch function of RESPECT/PRINT lists all information about code reviews that are done during a period.  
 
 

                    |----<----------------------|    

REVIEWED-OVERVIEW ------- FROM <yyyymmdd> ---------| 

                      |-- TO   <yyyymmdd> ---|       

                      |-- PROJECT <project> -|       

                      |-- USER <user> -------|       

                      |-- TASK <task> -------|       

                      |-- FILE <file> -------|       

 

 
Parameters Explanation 

 
FROM <yyyymmdd> 

 
This parameter is required. 
The begin date of the period.  
 

TO <yyyymmdd> The end date of the period. If this parameter is not used, then the end date is 
today. 
 

PROJECT <project> This parameter is optional and works as a filter: if used then only the files with 
this project or system are selected. 
 

USER <user-id> This parameter is optional and works as a filter: if used then only the files that 
are reviewed by this user are selected. 
 

TASK <task name> This parameter is optional and works as a filter: if used then only the files that 
are reviewed because of this task are selected. 
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FILE <file name> This parameter is optional and works as a filter: if used then only this file is 
selected. 
This is for debugging purposes. 
 

 

Example 
RUN RESPECT/PRINT("REVIEWED-OVERVIEW FROM 20220101 PROJECT SYS1"); 

 
 
 

  LOAD-CVIDE-FILES (Batch Function) 

This batch function (re)loads the templates for the CV-IDE solution and project file. These templates are required 
for the integration between SURE and ClearPath Visual IDE. 
 
Read TASK-1690-SURE for details. 
 

Example 
RUN RESPECT/REPOSITORY("LOAD-CVIDE-FILES"); 

 
 
 

  UPDATE-SOURCECOPY (Batch Function) 

Use this batch function to update the work directory of checked-out files in SURE when the local work directory of the 
developers is moved to another server. 
 
Read TASK-1627-SURE for details. 

 
When a source is checked-out with Local Editing enabled, the local work directory (where the source is placed on 
Windows) is linked to the file name. 
At check-in, the linked work directory is used to locate the file. 
 
If for some reason the work location of the developers is moved to another server, then this function can be used 
to change that in the repository as well, so that developers are still able to do check-in. 
 
 

                    |----<-----------------------|   

UPDATE-SOURCECOPY ------- FROM <old directory> ----| 

                      |-- TO <new directory ----|    

                      |-- DEBUG ----------------|    

 

 
Parameters Explanation 

 
FROM <old directory> 

 
The old server directory (where the files were originally placed at check-out) 
 

TO <new directory> The new server directory (where the files are moved to) 
 

DEBUG Give displays and do not do updates. 
 

 

Example 
RUN RESPECT/REPOSITORY("UPDATE-SOURCECOPY FROM \\server-1\ TO \\server-2\"); 
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  CHANGED-FILES (Batch Function) 

This batch function gives an overview of the files that are new, changed, or deleted in an environment. 
 
Read TASK-1741-SURE for details. 
 

Example 
RUN RESPECT/PRINT("CHANGED-FILES"); 
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 4 Full overview of tasks completed in release 110 
 
 
 
Group of tasks, manual selection 
 
SURE-2280 Received 15 Aug 2007 SOLVED (DENIED) 6 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Create a TASK selection dialog when committing a file from eclipse 
 

 
Solution: 

 
Denied 
 

 
SURE-2281 Received 15 Aug 2007 SOLVED (DENIED) 6 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Create a POPUP dialog which selects the directory when loading a new project in eclipse 
 

 
Solution: 

 
Denied 
 

 
SURE-2476 Received 1 Dec 2009 SOLVED (already-done) 5 Apr 2023 at 110  
 Reported by UOFW 
 Type IMPROVEMENT 
 Project SURE 
  

Make it possible to view a previous version of a program via NxEdit. 
 

  
 

 
SURE-2644 Received 4 Jul 2024 SOLVED 5 Jul 2024 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability CERTAIN 
  

Popup menu item text toggle no longer works. 
 

  
 

 
TASK-0594-SURE Received 3 Aug 2016 SOLVED (DENIED) 6 Oct 2023 at 110  
 Reported by SNS 
 Type FEATURE 
 Project SURE 
  

About the release numbers of SURE: the last data-part is confusing, can this be replaced by a build-sequence-number? 
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Solution: We keep the existing release number mechanism 
 

 
TASK-0826-GUI64 Received 31 Jul 2017 SOLVED 6 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Create installer for SURE 64-bit version. 
 

  
 

 
TASK-1456-SURE Received 27 Nov 2020 SOLVED 5 Apr 2023 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability POSSIBLE 
  

The status of a file is not updated after the file-type is changed and then transferred to the next environment 
 

  
 

 
TASK-1476-GUI64 Received 16 Dec 2020 SOLVED 5 May 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Convert the SURE client from 32-bits to a 64-bits application 
 

  
 

 
TASK-1582-SURE Received 3 Nov 2021 SOLVED 15 Sep 2022 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability POSSIBLE 
  

Aggregate small patches for SURE version 110 before functional changes 
 

  
 

 
TASK-1586-SURE Received 10 Nov 2021 SOLVED 6 Dec 2021 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Code Review: conversion program for old review remarks 
 

  
 

 
TASK-1590-SURE Received 7 Dec 2021 SOLVED 23 Dec 2021 at 110, 100  
 Reported by BBL 
 Type ERROR 
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 Project SURE 
 Severity MINOR 
 Probability POSSIBLE 
  

Generated repository directory names may contain double backslashes 
 

  
 

 
TASK-1591-SURE Received 16 Dec 2021 SOLVED 6 Jan 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability POSSIBLE 
  

Scrollbars of Task Maintenance dialog on a small screen may not be able to scroll to the last few positions 
 

  
 

 
TASK-1593-SURE Received 21 Dec 2021 SOLVED 22 Dec 2021 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

Reprocess Quick Fix gives a message 'Source not loaded in SURE' 
 

  
 

 
TASK-1594-SURE Received 3 Jan 2022 SOLVED 4 Jan 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Function Set Code Reviewed: The reference must be mandatory if a name-standard for REVIEW-REFERENCE is defined 
 

  
 

 
TASK-1595-SURE Received 5 Jan 2022 SOLVED 5 Jan 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability CERTAIN 
  

Show Review remarks: this gives a wrong timestamp when the review was done 
 

  
 

 
TASK-1597-SURE Received 12 Jan 2022 SOLVED 18 Jan 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
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 Probability LIKELY 
  

Download directory may not be presented / updated correctly in Sure Options screen. 
Determination of OS version uses Power Shell or Command Prompt, both of which may not be available on some 
workstations. 
 

  
 

 
TASK-1599-SURE Received 17 Jan 2022 SOLVED 17 Jan 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Suppress warning 'File is checked-out on another PC' if the local-work-directory and the local-source-directory are both 
located on another server which is defined via an URL-mapping 
 

  
 

 
TASK-1601-SURE Received 20 Jan 2022 SOLVED 20 Jan 2022 at 110, 100  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity NEGLIGIBLE 
 Probability POSSIBLE 
  

Function 'Delete project from team' sometimes gives strange response 
 

  
 

 
TASK-1602-SURE Received 24 Jan 2022 SOLVED 16 Mar 2022 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Function Add/Update properties: keep a history of the attributes that are changed 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1603-SURE Received 24 Jan 2022 SOLVED 11 Feb 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability POSSIBLE 
  

Review remarks: print to printer fails to print/open the generated report if the destination printer is PDF 
 

  
 

 
TASK-1604-SURE Received 26 Jan 2022 SOLVED 12 Feb 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
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Quick fix reprocessing for tasks TASK-1591-SURE, TASK-1597-SURE, TASK-1603-SURE. 
Removal of Control and Audit directories in tool/data repository definitions (obsolete). 
Changes to the way modeless dialogs from the SURE browser take input focus. 
Many non-functional changes in preparation of the equalization of the 32- and 64-bit versions. 
 

  
 

 
TASK-1606-SURE Received 11 Feb 2022 SOLVED 11 Feb 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Create extra SURE events when a task is transferred 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1608-SURE Received 15 Feb 2022 SOLVED 19 Feb 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

New print overview with all the files that are reviewed during a specific period 
 

 
Solution: 

 
The name of the new batch function is REVIEWED-OVERVIEW 
 

 
TASK-1609-SURE Received 16 Feb 2022 SOLVED 17 Mar 2022 at 110, 100  
 Reported by SNS 
 Type ERROR 
 Project SURE 
 Reference finding.354 
 Severity MINOR 
 Probability POSSIBLE 
  

System may not be able to find proper editor for opening temporary files without extension 
 

  
 

 
TASK-1610-SURE Received 19 Feb 2022 SOLVED 20 Feb 2022 at 110, 100  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability CERTAIN 
  

SURE backend on Windows: the form-feed in overviews does not work 
 

  
 

 
TASK-1611-SURE Received 20 Feb 2022 SOLVED 22 Feb 2022 at 110, 100  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
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New batch function to cleanup old code-review information 
 

 
Solution: 

 
The name of the new batch function is CLEAN-REVIEWED 
 

 
TASK-1617-SURE Received 8 Apr 2022 SOLVED 8 Apr 2022 at 110, 100  
 Reported by SNS 
 Type ERROR 
 Project SURE 
 Reference finding.356 
 Severity MODERATE 
 Probability POSSIBLE 
  

Task maintenance dialog: dependencies for field TaskGroup are not checked 
 

  
 

 
TASK-1618-SURE Received 12 Apr 2022 SOLVED 25 Apr 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability CERTAIN 
  

Folder Last Edited (of the SURE client) does not refresh after Checkout or Edit 
 

  
 

 
TASK-1620-SURE Received 25 Apr 2022 SOLVED 25 Apr 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MAJOR 
 Probability RARE 
  

Invalid index in RESPECT/SURE/COMPILE if exceptionally long Compiler Attributes are defined for a file 
 

  
 

 
TASK-1623-SURE Received 5 May 2022 SOLVED 31 May 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Use the defined MCP editor for function 'View version' on MCP files 
 

  
 

 
TASK-1626-SURE Received 9 May 2022 SOLVED 15 Sep 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Remove some obsolete file sets from the installation 
 



SURE Release 110 
 
 
Task 

   
Status 

Date 
ready 

 
Release 

 

Releasenotes110.docx 72  

  
 

 
TASK-1627-SURE Received 9 May 2022 SOLVED 23 May 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

New batch function to change the SOURCE-COPY relations so that they point to another server 
 

 
Solution: 

 
The full parameter of this batch function is as follows: 
 
    UPDATE-SOURCECOPY FROM <old server directory> TO <new server directory> 
 
For example 
    RUN RESPECT/REPOSITORY("UPDATE-SOURCECOPY FROM  \\SRVR1\  TO  \\SRVR2\ ")      
 
You can use this batch function when the local work directory of the developers is moved to another server. 
 
The issue is that the name of the local work directory is kept in SURE when a file is checked out. A checked-out file can 
only be checked in if the local work directory at check-in is the same as the local work directory at check-out.  
 
So, if a file is checked-out and the local work directory is then moved to another server, then that file cannot be checked-
in anymore.  
 
This batch function changes the server name in the work directory of the checked-out files to the new server name, to 
make check-in possible,  
  
 
 
 
 
 

 
TASK-1628-SURE Received 10 May 2022 SOLVED 11 May 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Implement Download  Server for directories with more than 120 files 
 

  
 

 
TASK-1629-SURE Received 11 May 2022 SOLVED 11 May 2022 at 110, 100  
 Reported by SNS 
 Type ERROR 
 Project SURE 
 Reference finding.360 
 Severity MINOR 
 Probability RARE 
  

A team leader cannot add a new team if new name is already known in SURE for another reason 
 

  
 

 
TASK-1630-SURE Received 11 May 2022 SOLVED 15 Sep 2022 at 110  
 Reported by BBL 
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 Type IMPROVEMENT 
 Project SURE 
  

Make each batch function only visible for the users with the right authorizations 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1633-SURE Received 16 May 2022 SOLVED 16 May 2022 at 110, 100  
 Reported by SNS 
 Type ERROR 
 Project SURE 
 Reference finding.362 
 Severity MINOR 
 Probability RARE 
  

Function Delete project from Team: the linked project-list is truncated after 200 lines 
 

  
 

 
TASK-1634-RIS Received 17 May 2022 SOLVED 22 May 2022 at 110, 100  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

New batch function: ABOUT-SURE 
New ODT function at Windows-backend: ABOUT <wildcard> 
 
Both functions give an overview of the creation-dates of the SURE software 
 

 
Solution: 

 
This batch function creates an overview with the following information: 
- For each installed RIS/SURE program: the release-id, creation date, and last access date 
- For each repository conversion: the date when the conversion was done 
 
 
 
 
 
 
 

 
TASK-1635-SURE Received 17 May 2022 SOLVED 18 May 2022 at 110, 100  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
 Reference finding.366 
  

Use the setting of global option 'Show files of all projects' also in the Compile Interface 
 

 
Solution: 

 
If the option is enabled, then each user can see the files of all projects/systems 
 

 
TASK-1636-SURE Received 24 May 2022 SOLVED 25 May 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
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New method to skip the automatic translation to uppercase of a token of the batch program input parameter 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1637-SURE Received 1 Jun 2022 SOLVED 1 Jun 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Function Download directory: remove the temporary DIR file when the download is done 
 

  
 

 
TASK-1639-SURE Received 7 Jun 2022 SOLVED 14 Aug 2023 at 110  
 Reported by ITSforSURE 
 Type DOCUMENT 
 Project SURE 
  

Update documentation of AW_OBJ.INI 
 

  
 

 
TASK-1641-SURE Received 13 Jun 2022 SOLVED 15 Jun 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Task group: lowercase characters are also allowed in the name 
 

  
 

 
TASK-1642-SURE Received 14 Jun 2022 SOLVED 15 Jun 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Support to de-activate a usercode-directory via drop down list 
 

 
Solution: 

 
A SURE user-id must be disabled via Organization --> User 
An MCP usercode must be disabled via Configuration --> Drop down box --> Usercode 
 

 
TASK-1643-SURE Received 15 Jun 2022 SOLVED 17 Aug 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Improve support for global drop-down lists 
 

  
 

 
TASK-1644-SURE Received 22 Jun 2022 SOLVED 28 Jul 2022 at 110, 100  
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 Reported by SNS 
 Type FEATURE 
 Project SURE 
 Reference finding.358 
  

Examine: scan python script pc-sources for programs that are started by the script 
 

  
 

 
TASK-1645-SURE Received 29 Jun 2022 SOLVED 25 Aug 2022 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability POSSIBLE 
  

Leak in code-review procedure: the request for code-review is not always added after a delink + link 
 

  
 

 
TASK-1648-RIS Received 13 Jul 2022 SOLVED 13 Jul 2022 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability CERTAIN 
  

Batch function Deliver tasks: dumped formats are not deleted from the to-dump queue. So they are delivered 
repeatedly. 
 

  
 

 
TASK-1649-SURE Received 14 Jul 2022 SOLVED 14 Jul 2022 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability RARE 
  

Function View sometimes gives no response 
 

  
 

 
TASK-1652-SURE Received 27 Jul 2022 SOLVED 27 Jul 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Remove unused functionality in RIS/MENU that a documentation text file is checked-out and checked-in together with 
a source 
 

  
 

 
TASK-1655-RIS Received 14 Aug 2022 SOLVED 17 Aug 2022 at 110, 100  
 Reported by SNS 
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 Type IMPROVEMENT 
 Project SURE 
  

New: the last run date of a program is now also kept in a relation with class LAST-RUN 
 

 
Solution: 

 
There is also a conversion function to create LAST-RUN relations from earlier loaded statistics records 
   RUN RESPECT/REPOSITORY("CONVERT 78") 
 

 
TASK-1656-SURE Received 15 Aug 2022 SOLVED 15 Aug 2022 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Folder Drop Down Boxes: sort the lines in alphabetical order 
 

  
 

 
TASK-1657-SURE Received 17 Aug 2022 SOLVED 20 Aug 2022 at 110, 100  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Extra column in the Run Statistics that shows the compilation date of the object that ran 
Release 100: prepare the column for release 110 
 

  
 

 
TASK-1659-RIS Received 30 Aug 2022 SOLVED 30 Aug 2022 at 110, 100  
 Reported by ORDINA 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability CERTAIN 
  

RESPECT/SURE/EXAMINE removes the DATABASE relation that is linked to generated MicroFocus COBOL programs 
 

 
Solution: 

 
The solution is: if one of the copy-files of a source has relation INVOKE <database-name>, then Examine will add relation 
DATABASE <database-name> to that source. 
The INVOKE <database-name> relation must be linked manually to a copy-file: 
   Environment = <environment> 
   Group = FILE-CONTROL 
   Owner = <the copy-file> 
   Class = INVOKE 
   Asset = <database-name>    
 
 
 
 
 

 
TASK-1660-SURE Received 31 Aug 2022 SOLVED 31 Aug 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  



SURE Release 110 
 
 
Task 

   
Status 

Date 
ready 

 
Release 

 

Releasenotes110.docx 77  

Improve functions Assign and Undo Request if the task wherefore the Request was done is deleted 
 

  
 

 
TASK-1661-SURE Received 31 Aug 2022 SOLVED 31 Aug 2022 at 110, 100  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Small improvements for Logon via Windows Account in the case that the SURE UserId differs from the Windows account 
 

 
Solution: 

 
The following changes are made:  
1. It is not allowed to log-on if the Windows account is de-activated 
2. If the Windows account is de-activated or deleted, then the links between the Windows account and SURE usercodes 
are removed. 
3. If a SURE user-id is de-activated or deleted, then the links between the SURE user-id and Windows accounts are 
removed. 
4. It is not possible to link a SURE user-id to a de-activated Windows account 
 

 
TASK-1662-SURE Received 6 Sep 2022 SOLVED 15 Sep 2022 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Make it possible to define a default project and file-type for a directory. The defaults are pre-filled when a new file is 
added in that directory 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1663-SURE Received 13 Sep 2022 SOLVED 13 Sep 2022 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Implement function 'Clear code-review' in RIS/MENU 
 

 
Solution: 

 
This is implemented via the following new commands in RIS/MENU => SURE 
 
Clear all code review requests of a file: 
   Command = CLEARREVIEW 
   File = <filename> 
 
Clear the Code Review request of a file for a specific task: 
   Command = CLEARREVIEW  <task-name> 
   File = <filename> 
 

 
TASK-1665-SURE Received 19 Sep 2022 SOLVED 20 Sep 2022 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability CERTAIN 
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SURE backend on Windows: Function List File does not work properly for PC files 
 

  
 

 
TASK-1666-SURE Received 20 Sep 2022 SOLVED 20 Sep 2022 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
 Reference finding.372 
  

Function View FileVersion on a MicroFocus COBOL PC-file: Write in the first comment line of the created file the File 
Version number of the source 
 

  
 

 
TASK-1668-SURE Received 5 Oct 2022 SOLVED 15 Nov 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Update help info, implement Help button on RFW formats with generated buttons 
 

  
 

 
TASK-1670-SURE Received 13 Oct 2022 SOLVED 14 Nov 2022 at 110  
 Reported by BBL 
 Type FEATURE 
 Project SURE 
  

Review the options 'Insert carriage return and line feed' and 'Remove carriage return and line feed' for the following 
functions: 
 - Check-out MCP data file 
 - Check-in MCP data file  
 - View MCP data file 
 - Upload MCP data file 
 - Download MCP data file 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1671-SURE Received 17 Oct 2022 SOLVED 17 Oct 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Function Show Code Review remarks: show the newest remarks on top 
 

  
 

 
TASK-1673-SURE Received 1 Nov 2022 SOLVED 4 Nov 2022 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Show the review status on the task reports 
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Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1674-SURE Received 7 Nov 2022 SOLVED 8 Nov 2022 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Do not allow to link a PC file-type to an MCP file, or an MCP file-type to a PC file. 
 

  
 

 
TASK-1676-SURE Received 15 Nov 2022 SOLVED 28 Nov 2022 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Implement SURE-find in delta files 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1677-SURE Received 5 Dec 2022 SOLVED 6 Dec 2022 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

User overview: show the last date that a user logged on 
 

  
 

 
TASK-1678-SURE Received 6 Dec 2022 SOLVED 22 Dec 2022 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Update help information 
 

  
 

 
TASK-1679-SURE Received 3 Jan 2023 SOLVED 9 Jan 2023 at 110  
 Reported by BBL 
 Type FEATURE 
 Project SURE 
  

Make it possible to change the background color of the SURE browser 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1680-SURE Received 9 Jan 2023 SOLVED 9 Jan 2023 at 110  
 Reported by ITSforSURE 
 Type ERROR 
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 Project SURE 
 Severity MODERATE 
 Probability POSSIBLE 
  

Crash of RESPECT/SURE/FIND if an empty file is scanned 
 

  
 

 
TASK-1681-SURE Received 9 Jan 2023 SOLVED 10 Jan 2023 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Function Select File: make it possible to enter a directory name. 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1682-SURE Received 24 Jan 2023 SOLVED 10 Mar 2023 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Task history of a file: skip repeating lines with the same task name 
 

  
 

 
TASK-1683-SURE Received 3 Mar 2023 SOLVED 3 Mar 2023 at 110  
 Reported by SNS 
 Type ERROR 
 Project SURE 
 Reference finding.373 
 Severity MAJOR 
 Probability POSSIBLE 
  

SURE backend on Windows: Examine fails if a source is examined simultaneously by two different examine programs 
 

  
 

 
TASK-1684-SURE Received 10 Mar 2023 SOLVED 10 Mar 2023 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Update user attributes log: if nothing changed at the update then mention that in the log 
 

  
 

 
TASK-1685-SURE Received 27 Mar 2023 SOLVED 29 Mar 2023 at 110, 100, 90  
 Reported by UNISYS 
 Type IMPROVEMENT 
 Project SURE 
  

Create the default INFDB description file for DMS release 631 
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TASK-1686-SURE Received 5 Apr 2023 SOLVED 5 Apr 2023 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

RESPECT/SURE/COMPILE leaves job-files in directory SURESOURCE/= on disk. Clean them up. 
 

  
 

 
TASK-1687-SURE Received 6 Apr 2023 SOLVED 7 Apr 2023 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Function Rename File: do not link the file to the task if the file has status REMOVED 
 

  
 

 
TASK-1688-SURE Received 12 Apr 2023 SOLVED 31 Aug 2023 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Reprocess Quick fix: show after the quick-fix the new file-version on the quick-fix screen 
 

  
 

 
TASK-1689-SURE Received 22 May 2023 SOLVED 6 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Move INFDB transaction parameters from Repositories to INI file 
 

  
 

 
TASK-1690-SURE Received 22 May 2023 SOLVED 29 Aug 2023 at 110, 100, 90  
 Reported by UNISYS 
 Type FEATURE 
 Project SURE 
  

Integration between SURE and ClearPath Visual IDE 
 

  
Controls 

 
TASK-1693-SURE 

 
Integration CVIDE (part 2) 

  TASK-1704-SURE Integration between SURE and ClearPath Visual IDE part 2 
  TASK-1718-SURE CV-IDE editor: use 'Default build' when the source has filekind JOBSYMBO 
  TASK-1722-SURE CV-IDE editor: the file extension for WIDESYMBOL files must be wde_m 
 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1692-SURE Received 21 Jun 2023 SOLVED 22 Jun 2023 at 110  
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 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Improve performance of function 'Task ready' 
 

  
 

 
TASK-1693-SURE Received 22 Jun 2023 SOLVED 22 Jun 2023 at 110, 100  
 Reported by UNISYS 
 Type IMPROVEMENT 
 Project SURE 
  

Integration CVIDE (part 2) 
 

  
Dependent of 

 
TASK-1690-SURE 

 
Integration between SURE and ClearPath Visual IDE 

  
 

 
TASK-1694-SURE Received 23 Jun 2023 SOLVED 30 Jun 2023 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

A new naming standard option where the numeric part gets leading zeroes if the entered number is smaller than the 
number in the formula 
 

 
Solution: 

 
The following naming standard options are now possible for a numeric part of the name: 
 
([9999999]) 
- In this case the length of a numeric part of the entered name must be exactly 7 digits. 
 
([8888888]) 
- In this case the length of a numeric part of the entered name must be between 1 and 7 digits. 
- Leading zeroes (â€œ0â€•) are added if the length is less than 7 digits. 
 
([ZZZZZZZ]) 
- In this case the length of a numeric part of the entered name must be between 1 and 7 digits. 
- Leading zeroes (â€œ0â€•) are not added if the length is less than 7 digits. 
 

 
TASK-1695-SURE Received 4 Jul 2023 SOLVED 26 Apr 2024 at 110, 100  
 Reported by BBL 
 Type FEATURE 
 Project SURE 
  

Improvements for Task Reference. 
- Implement option: 'Task reference required'. The option can be defined for an environment. A task without reference 
cannot be transferred to that environment if the option is enabled. 
- Show the task reference on the task transfer screen, plus a button to update the reference.  
- Make it possible to validate the task reference when entered. 
 

  
Controls 

 
TASK-1696-SURE 

 
Reprocess patches for 'task reference' at release 100 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
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TASK-1696-SURE Received 11 Jul 2023 SOLVED 11 Jul 2023 at 110, 100  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Reprocess patches for 'task reference' at release 100 
 

  
Dependent of 

 
TASK-1695-SURE 

 
Improvements for Task Reference. 

  
 

 
TASK-1701-SURE Received 8 Aug 2023 SOLVED 8 Aug 2023 at 110  
 Reported by ITSforSURE 
 Type DOCUMENT 
 Project SURE 
  

Evaluate UltraEdit to use it as local editor for MCP source files, and describe the configuration 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1702-SURE Received 9 Aug 2023 SOLVED 9 Aug 2023 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

Crash RESPECT/SURE/EXAMINE on a data file with maxrecsize > 1000 
 

  
 

 
TASK-1703-SURE Received 14 Aug 2023 SOLVED 15 Aug 2023 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Function Recover File: delete TO-REVIEW markers for the file in the recover-destination environments 
 

  
 

 
TASK-1704-SURE Received 29 Aug 2023 SOLVED 29 Aug 2023 at 110, 100, 90  
 Reported by UNISYS 
 Type IMPROVEMENT 
 Project SURE 
  

Integration between SURE and ClearPath Visual IDE part 2 
 

  
Dependent of 

 
TASK-1690-SURE 

 
Integration between SURE and ClearPath Visual IDE 

  
 

 
TASK-1707-SURE Received 7 Sep 2023 SOLVED 7 Sep 2023 at 110  
 Reported by SNS 
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 Type IMPROVEMENT 
 Project SURE 
 Reference finding.375 
  

Allow to close a master task if all subtasks have status SOLVED 
 

  
 

 
TASK-1708-SURE Received 7 Sep 2023 DEVELOP-RIS (BUSY)    
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
 Assigned to user SIMON 
  

Notes of release 110 
 

  
Linked 

 
FILE 

 
Ris\A\Sure\Document\Releasenotes110.docx 

  
 

 
TASK-1709-SURE Received 26 Sep 2023 SOLVED 26 Apr 2024 at 110  
 Reported by SNS 
 Type FEATURE 
 Project SURE 
  

Windows backend: implement site library 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1710-SURE Received 28 Sep 2023 SOLVED 6 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Use Notepad++ as local editor for MF-COBOL files and MCP source files 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1711-SURE Received 4 Oct 2023 SOLVED 6 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability CERTAIN 
  

Automatic upgrade for SURE installations does not work for new installation procedure 
 

  
 

 
TASK-1712-SURE Received 12 Oct 2023 SOLVED 12 Oct 2023 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
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Allow to delink a subtask from a master task via the task-transfer screen 
 

  
 

 
TASK-1714-SURE Received 17 Oct 2023 SOLVED 17 Oct 2023 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Change program RESPECT/SURE/ALWAYS/LISTING to batch function CHANGE-ALWAYS-LISTING in RESPECT/REPOSITORY 
 

  
 

 
TASK-1716-SURE Received 23 Oct 2023 SOLVED 27 Oct 2023 at 110, 100, 90  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

New batch function to start a job under another usercode/pack 
 

  
 

 
TASK-1718-SURE Received 7 Nov 2023 SOLVED 10 Nov 2023 at 110, 100, 90  
 Reported by UOFW 
 Type IMPROVEMENT 
 Project SURE 
  

CV-IDE editor: use 'Default build' when the source has filekind JOBSYMBOL, DATA, SEQDATA or TEXTDATA 
 

  
Dependent of 

 
TASK-1690-SURE 

 
Integration between SURE and ClearPath Visual IDE 

  
 

 
TASK-1719-SURE Received 8 Nov 2023 SOLVED 19 Feb 2024 at 110  
 Reported by ITSforSURE 
 Type FEATURE 
 Project SURE 
  

Adapt code of all systems/projects to move to Visual Studio 2022 
 

  
 

 
TASK-1722-SURE Received 15 Nov 2023 SOLVED 12 Jan 2024 at 110, 100, 90  
 Reported by UOFW 
 Type IMPROVEMENT 
 Project SURE 
  

CV-IDE editor: the file extension for WIDESYMBOL files must be wde_m 
- enable the vertical line that indicates the maximum record length 
 

  
Dependent of 

 
TASK-1690-SURE 

 
Integration between SURE and ClearPath Visual IDE 
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TASK-1724-SURE Received 29 Nov 2023 SOLVED 1 Dec 2023 at 110, 100, 90  
 Reported by UOFW 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

RESPECT/SURE/COMPILE aborts because of an invalid index 
 

 
Solution: 

 
This happened when very lengthy compiler attributes are defined for the system of the file 
 

 
TASK-1728-SURE Received 4 Jan 2024 SOLVED 8 Jan 2024 at 110, 100, 90  
 Reported by UOFW 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

RESPECT/SURE/FIND crashes when an empty PC-file is in the find queue 
 

 
Solution: 

 
This happened when an empty PC-file was added to the FIND-queue 
 

 
TASK-1729-SURE Received 4 Jan 2024 SOLVED 19 Feb 2024 at 110, 100  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

New option to enforce that code review assessment is only allowed for developers that are linked to the project of the 
file 
 

  
 

 
TASK-1730-SURE Received 11 Jan 2024 SOLVED 12 Jan 2024 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

File must be code-reviewed after functions Rollback and Reprocess QuickFix 
 

  
 

 
TASK-1731-SURE Received 15 Jan 2024 SOLVED 15 Jan 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Button Compile Impact (on the Task Transfer screen) gives a time out 
 

  
 

 
TASK-1732-SURE Received 17 Jan 2024 SOLVED 19 Feb 2024 at 110, 100  
 Reported by BBL 
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 Type FEATURE 
 Project SURE 
  

New batch function to clone a usercode 
 

  
 

 
TASK-1733-SURE Received 17 Jan 2024 SOLVED 4 Mar 2024 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability POSSIBLE 
  

Issues found while testing: 
1. Error message "Cannot construct transaction identification: AR_Sure CheckBitmapFile". 
2. Error message "Cannot construct transaction identification: AR_Sure CheckSpaces". 
3. Drag/drop no longer working. 
4. Fixed font is rendered as proportional. 
5. Task variable fields are updated but not inquired properly. 
6. Browser restore does not work properly on different open node sets on multiple environments. 
7. FileXfer entries created in GetCVIDEFiles are not moved to completed queue properly. 
 

  
 

 
TASK-1734-SURE Received 7 Feb 2024 SOLVED 7 Feb 2024 at 110, 100  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

Some tasks have a space-item as task-reference. The checks on task-reference do not work properly for these tasks 
 

  
 

 
TASK-1735-SURE Received 7 Feb 2024 SOLVED 7 Feb 2024 at 110, 100  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Function Recover must remove the TO-REVIEW relations in the destination environment 
 

  
 

 
TASK-1736-SURE Received 1 Mar 2024 SOLVED 4 Mar 2024 at 110, 100, 90  
 Reported by UOFW 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

The CV-IDE editor cannot load a checked-out file properly. 
 

 
Solution: 

 
This happened when the original file that is loaded in SURE has a deviating MAXRECSIZE or FRAMESIZE. 
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At check-out, the MAXRECSIZE and FRAMESIZE of the checked-out file are now set to the default values. These default 
values are then used by CV-IDE and saved in SURE at check-in 
 

 
TASK-1737-SURE Received 4 Mar 2024 SOLVED 5 Mar 2024 at 110  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability POSSIBLE 
  

A recovered file disappears from the linked list of a task 
 

  
 

 
TASK-1738-SURE Received 13 Mar 2024 SOLVED 20 Mar 2024 at 110, 100, 90  
 Reported by UOFW 
 Type FEATURE 
 Project SURE 
  

Implement 'View via CV-IDE' if CV-IDE is defined as editor for MCP files 
 

  
 

 
TASK-1739-SURE Received 18 Mar 2024 SOLVED 20 Mar 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Make the REVIEWED-OVERVIEW also available as a CSV file 
 

 
Solution: 

 
This is implemented via the following new option for batch function REVIEWED-OVERVIEW: 
 - ALSO-CSV: If this option is used, then a CSV file is created. The name of the file is RESPECT/DUMP/REVIEWED 
 - CSV-SEP <char>: The default CSV separator is a comma. This option changes the separator 
 

 
TASK-1740-SURE Received 20 Mar 2024 SOLVED 20 Mar 2024 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability RARE 
  

Cannot reprocess quick fixes if the task history contains an unchanged format or file 
 

  
 

 
TASK-1741-SURE Received 21 Mar 2024 SOLVED 20 Jun 2024 at 110  
 Reported by BBL 
 Type FEATURE 
 Project SURE 
  

Overview of new, changed, or deleted files 
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Solution: See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1742-SURE Received 28 Mar 2024 SOLVED 16 May 2024 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability CERTAIN 
  

1. Local compile does not show Upload copy files dialog. 
2. Creating an empty error file on a successful compile may fail if directory is not present. 
 

  
 

 
TASK-1743-SURE Received 28 Mar 2024 SOLVED 16 May 2024 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Make sub-entries of Datamodel entries correctly drag to right panes 
 

  
 

 
TASK-1744-SURE Received 4 Apr 2024 SOLVED 9 Apr 2024 at 110, 100, 90  
 Reported by CEDAE 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

Crash during function 'Load MCP files in SURE' 
 

 
Solution: 

 
This happened when the total length of the usercode + directory + packname (of the files that must be loaded) is too 
long 
 

 
TASK-1745-SURE Received 19 Apr 2024 SOLVED 26 Apr 2024 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability POSSIBLE 
  

Function Edit on multiple Files from browser node Last Edited may cause unpredictable results 
 

  
 

 
TASK-1746-RIS Received 13 May 2024 SOLVED 10 Jul 2024 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Improve warning 'Concurrent Maintenance' for PC files 
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TASK-1747-SURE Received 16 May 2024 SOLVED 27 May 2024 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Windows 64-bit redistributable dllï¿½s are not all loaded in SU 
 

  
 

 
TASK-1748-SURE Received 27 May 2024 SOLVED 15 July 2024  at 110 
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Change vcxproj files to Windows 10 
!!! Part of TASK-1747-SURE, overlaps with TASK-1727-SURE !!! 
 

  
 

 
TASK-1749-SURE Received 30 May 2024 SOLVED 10 Jun 2024 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Revision of the NxEdit working mode 
 

  
 

 
TASK-1750-SURE Received 3 Jun 2024 SOLVED 20 Jun 2024 at 110  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability POSSIBLE 
  

Interrupt dialog on Task Transfer screen function Compile Impact does not close when impact response format is shown. 
 

  
 

 
TASK-1751-SURE Received 13 Jun 2024 SOLVED 20 Jun 2024 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Restore working of customized task attributes for the Task object screen 
 

  
 

 
TASK-1752-SURE Received 18 Jun 2024 SOLVED 20 Jun 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
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Improve the domain check: if a file has multiple domains, then it can only be maintained by users who have all those 
domains 
 

  
 

 
TASK-1753-SURE Received 19 Jun 2024 SOLVED 12 Jul 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

MCP Source Editor: improve Paste Special handling at specific line positions 
 

  
 

 
TASK-1755-SURE Received 4 Jul 2024 SOLVED 15 Jul 2024 at 110  
 Reported by UNISYS 
 Type IMPROVEMENT 
 Project SURE 
  

Make it impossible to lock yourself out from the security mechanism 
 

  
 

 
TASK-1756-SURE Received 11 Jul 2024 SOLVED 12 Jul 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Make it possible to add P-CODE relations via the SURE client 
 

  
 

 
TASK-1757-SURE Received 13 Jul 2024 SOLVED 13 Jul 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Kerberos session number must be above 10000 
 

  
 

 
TASK-1758-SURE Received 17 Jul 2024 SOLVED 7 Feb 2025 at 110  
 Reported by UOFW 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability LIKELY 
  

Some dates on the task screen (with ini-option TASKMAINT-OBJECT) are not correctly displayed 
SURE log screen: The 'PM' and 'AM' indication of a time value is sometimes truncated 
 

 
Solution: 

 
This happened at the following Windows Region settings: 
- date = MM/d/yyyy    (US style) 
- time = h:mm:ss tt       (US style) 
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SURE manages the US style of the Windows Region settings now correctly 
 

 
TASK-1759-SURE Received 2 Aug 2024 SOLVED 22 Aug 2024 at 110, 100  
 Reported by PRODESP 
 Type IMPROVEMENT 
 Project SURE 
  

Allow to RESTORE a file via RESPECT/SURE/BATCH 
 

 
Solution: 

 
WFL RUN OBJECT/RESPECT/SURE/BATCH("ACT","<file-name","") 
 

 
TASK-1760-SURE Received 15 Aug 2024 SOLVED 19 Aug 2024 at 110  
 Reported by SNS 
 Type ERROR 
 Project SURE 
 Severity MAJOR 
 Probability RARE 
  

SURE backend on Windows: The Scheduler was started many times. After a while up to 50 Schedulers were active 
 

 
Solution: 

 
The extra Schedulers were started because WMI (Windows Management Instrumentation) was not working for a while.  
So, we added extra checks:  
- If WMI is not active, then the Scheduler is paused until WFL is active again 
- When the Scheduler starts, then he immediately goes to end-of-job if another instance of the Scheduler is already busy. 
 

 
TASK-1761-SURE Received 27 Aug 2024 SOLVED 7 Feb 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Review the layout of Icons and Browses in the SURE-GUI 
 

  
 

 
TASK-1762-SURE Received 27 Nov 2024 SOLVED 29 Nov 2024 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
  

Some changes in overview CHANGED-FILES 
 

  
 

 
TASK-1764-SURE Received 23 Oct 2024 SOLVED 16 Jan 2025 at 110  
 Reported by RVA 
 Type IMPROVEMENT 
 Project SURE 
  

Quick fix to separately release patch for samba share caching problem 
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TASK-1767-SURE Received 16 Dec 2024 SOLVED 16 Jan 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Improve the way the SURE browser repositions when a node list is opened or closed 
 

  
 

 
TASK-1768-SURE Received 31 Dec 2024 SOLVED 15 Jan 2025 at 110  
 Reported by ANDIMA 
 Type FEATURE 
 Project SURE 
  

New option for RESPECT/SURE/TRANSFER to copy the objects via FTP 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
TASK-1769-SURE Received 16 Jan 2025 SOLVED 16 Jan 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Set the release number to 110.2 
 

  
 

 
TASK-1771-XX Received 6 Feb 2025 SOLVED 11 Feb 2025 at 110  
 Reported by SNS 
 Type IMPROVEMENT 
 Project SURE 
  

Replace deprecated wmic with PowerShell 
 

 
Solution: 

 
Run PowerShell via the Windows Start button with option 'Run as Administrator' 
Enter the following command: 
    PowerShell set-executionpolicy unrestricted 
 

 
TASK-1772-SURE Received 7 Feb 2025 SOLVED 7 Feb 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Implement option QUERY for batch function SELECT 
 

  
 

 
TASK-1773-SURE Received 7 Feb 2025 SOLVED 7 Feb 2025 at 110  
 Reported by BBL 
 Type IMPROVEMENT 
 Project SURE 
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Make it possible to exclude specific role overlaps. For example: a RELEASE-MANAGER cannot be a DEVELOPER 
 

  
 

 
TASK-1774-SURE Received 10 Feb 2025 SOLVED 11 Feb 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Change date on the 'Add License' screen to 3 separate fields: YYYY, MM and DD 
 

  
 

 
TASK-1775-SURE Received 11 Feb 2025 SOLVED 11 Feb 2025 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability LIKELY 
  

Query history is not always properly retrieved 
 

  
 

 
TASK-1776-SURE Received 27 Feb 2025 SOLVED 3 Mar 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Resync Bitmap directory and list of linked in bitmap resources 
 

  
 

 
TASK-1777-SURE Received 28 Feb 2025 SOLVED 3 Mar 2025 at 110  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MAJOR 
 Probability POSSIBLE 
  

SURE Browser restore fails if key numbers in INI section [SURELEFTRESTORE] are not consecutive 
 

  
 

 
TASK-1778-SURE Received 14 Mar 2025 SOLVED 19 Mar 2025 at 110  
 Reported by BBL 
 Type FEATURE 
 Project SURE 
  

Implement domain check for inquiry functions LIST and VIEW 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
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TASK-1779-SURE Received 19 Mar 2025 SOLVED 19 Mar 2025 at 110, 100  
 Reported by PRODESP 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability RARE 
  

It is not possible to view an error-file via the Compile Interface 
 

 
Solution: 

 
This happened when 'NORMAL' was defined as a compile-queue 
 

 
TASK-1780-SURE Received 19 Mar 2025 SOLVED 23 May 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Improve the SURE-CVIDE interface, so that multiple checked-out MCP files are opened in one VisualStudio/CVIDE project 
 

  
 

 
TASK-1783-SURE Received 7 Apr 2025 SOLVED 24 Apr 2025 at 110  
 Reported by ITSforSURE 
 Type IMPROVEMENT 
 Project SURE 
  

Improve the Task Statistics Overview 
 

  
 

 
TASK-1784-SURE Received 16 Apr 2025 SOLVED 18 Apr 2025 at 110  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability POSSIBLE 
  

Overview CHANGED-FILES does not show deleted files 
 

  
 

 
TASK-1785-SURE Received 17 Apr 2025 SOLVED 18 Apr 2025 at 110  
 Reported by BBL 
 Type ERROR 
 Project SURE 
 Severity SEVERE 
 Probability RARE 
  

Code review: a quick-fixed file does not get status TO-REVIEW, if the task is a dependent task 
 

  
 

 
TASK-1786-SURE Received 29 Apr 2025 SOLVED 29 Apr 2025 at 110  
 Reported by BBL 
 Type ERROR 
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 Project SURE 
 Severity MINOR 
 Probability RARE 
  

Authorization bit 'To Transfer' cannot be enabled 
 

 
Solution: 

 
This could happen when a datacom translate table is activated (to translate diacritic characters to normal characters) 
 

 
TASK-1787-SURE Received 29 Apr 2025 SOLVED 23 May 2025 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MINOR 
 Probability POSSIBLE 
  

Refresh on a right pane does not work if there are no data lines in it 
 

  
 

 
TASK-1789-SURE Received 8 May 2025 SOLVED 9 May 2025 at 110  
 Reported by UOFW 
 Type IMPROVEMENT 
 Project SURE 
  

Improve the text of some error messages 
 

  
 

 
TASK-1791-SURE Received 22 May 2025 SOLVED 23 May 2025 at 110  
 Reported by ITSforSURE 
 Type ERROR 
 Project SURE 
 Severity MODERATE 
 Probability CERTAIN 
  

Some ADDS status/info functions do not use the DD name properly 
 

  
 

 
TASK-1793-SURE Received 4 Jun 2025 SOLVED 11 June 2025 at 110  
 Reported by ANDIMA 
 Type IMPROVEMENT 
 Project SURE 
  

Extra option for RESPECT/SURE/TRANSFER to enforce a job-wait status via WAIT(FILE xx IS RESIDENT), instead of a wait 
via program RESPECT/TOOLS 
 

 
Solution: 

 
See the task explanation form or the task attachment in SURE for detailed information 
 

 
 
 


	1 Notes for the SURE 110 release
	1.1 Introduction
	1.2 Migration
	1.3 Installing the mainframe software
	1.3.1 Install new objects and upgrade/create a repository

	1.4 Compatibility
	1.4.1 Database compatibility
	1.4.2 Compatibility with MCP releases
	1.4.3 Compatibility with previous SURE releases
	1.4.4 Compatibility with Windows versions

	1.5 Upgrading the SURE software to release 110.x
	1.5.1 Automatic upgrade feature of the client software.
	1.5.2 Multiple installations of the SURE client on one workstation
	1.5.3 About SURE release numbers


	2 Features and improvements
	2.1 Detailed descriptions of the most important new features, release 110.x
	Task-1573-SURE Define Help-information for the screens under folder Datamodel
	Task-1602-SURE Update properties: keep a log of the changes
	Task-1606-SURE Extra events in the SURE log when a task is transferred
	Task-1630-SURE Make each batch function only visible for users with right privileges
	Task-1636-SURE New method to handle the parameters of batch programs
	Task-1662-SURE Define a default project and file-type for a directory
	Task-1670-SURE Review support for MCP data files that are loaded in SURE
	Task-1673-SURE Show the review status on the task forms
	Task-1676-SURE Implement SURE Find in delta files
	Task-1679-SURE Change the background color of the SURE browser
	Task-1681-SURE Function Select file: allow to enter a directory name
	Task-1690-SURE Use ClearPath Visual IDE as editor for MCP sources
	Task-1695-SURE Improvements for Task Reference
	Task-1701-SURE Use UltraEdit as local editor for MCP sources
	Task-1709-SURE Implement SURE Site Library for the SURE Windows backend
	Task-1710-SURE Use Notepad++ as local editor for MCP sources
	Task-1741-SURE Overview of new, changed, and deleted files
	Task-1768-SURE New option to deploy compiled objects via FTP instead of BNA
	Task-1778-SURE Implement domain check for list and view functions
	Task-1793-SURE New option to WAIT-ON-FILE-RESIDENT at incorrect deploy


	3 New or deleted batch programs and batch functions
	ABOUT-SURE (Batch Function)
	ALWAYS-LISTING (Batch Function)
	CLEAN-REVIEWED (Batch Function)
	REVIEWED-OVERVIEW (Batch Function)
	LOAD-CVIDE-FILES (Batch Function)
	UPDATE-SOURCECOPY (Batch Function)
	CHANGED-FILES (Batch Function)

	4 Full overview of tasks completed in release 110

